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September 30, 2021

Citrix licensing is a system of components that functions together. Before you use any of your Citrix
products, learn about licensing components. Citrix licensing system includes:

« License Server - Every Citrix product environment must have at least one shared or dedicated
License Server. Servers running Citrix products contact the License Server to obtain licenses.
For more information, see License Server.

+ License files - The license file is a text file containing the product licensing information, License
Server name, license expiration date and other information. For more information, see License

files.

« Citrix Licensing Manager - The Citrix Licensing Manager is a web based management console for
Citrix Licensing. For more information, see Citrix Licensing Manager.

+ Licensing Services - The Citrix Licensing service is the Windows service responsible for the fol-
lowing core licensing functionality:

Citrix Web Services for Licensing

Citrix Licensing Support Service

Citrix Licensing WMI
CITRIX vendor daemon

For more information, see Licensing services.
+ Product-side settings in your Citrix products that are associated with the License Server.

For more information about licensing components, see Citrix licensing technical overview.

Citrix licensing: User workflow

The following image describes the Citrix licensing workflow.
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Key

x- Before downloading and installing the License Server, an existing user logs on to citrix.com, while
a new user creates a citrix.com account.

CC - Citrix Cloud

CLM - Citrix Licensing Manager
LAC - License Access Code

LS - License Server

LUI - License Usage Insights

What’s new

September 20, 2021
Note:

Citrix is working to improve the licensing experience in My Account on citrix.com. You can choose
Manage Licenses to easily find, allocate, download, hide, and unhide licenses. The legacy All
Licensing Tools experience is still available for a limited time.

What’s new in the License Server version 11.17.2 build 36000
Support for 4096 key size in self-signed certificates

From this release onwards, the key size supported in self-signed certificates is 4096 only. Uninstall
the existing License Server and install the upgraded version (11.17.2.0 build 36000) which contains
the 4096 key length self-signed certificate. To create your own self-signed certificate, see Get started.

OpensSSL version upgrade

OpenSSL version: 1.1.1k

Apache version update

Apache version 2.4.48.
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What’s new in the License Server version 11.17.2 build 35000
Windows Server 2022 support

The Citrix components and technologies in this release that support Windows Server platforms now
also support Windows Server 2022, unless otherwise noted. For more information, see Windows
Server 2022 support.

A support bundle to troubleshoot License Server issues

A support bundle (.zip file) contains information that Citrix Support team uses to troubleshoot and
debug license server issues. You can use this file to initiate a Citrix support call or to provide docu-
mentation to Citrix or its agents for license compliance purposes. For more information, see Support
Bundle.

OpenSSL version upgrade

OpenSSL version: 1.1.1i

What’s new in the License Server build 34000
Lmadmin.exe transitioned to Lmgrd.exe

In this release, the Citrix License Server’s existing user management Imadmin.exe is transitioned to
Citrix owned user management lmgrd.exe for improved security and less third party dependencies.

OpensSSL version upgrade

OpenSSL version: 1.1.1h

Libxml2 version upgrade

libxml2 version: 2.9.10

What’s new in the License Server build 33000
A new configuration option added to the Configure usage telemetry

« With the new option under Configure usage telemetry you can choose not to send data or to
send data in an unidentifiable format.

For more information, see Configure usage telemetry.
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Apache version update

Apache version 2.4.46.

OpenSSL version upgrade

OpenSSL1.1.1g

Fixed issues

September 14, 2021

Fixed issues in License server version 11.17.2 build 36000

« When registering your License Server with Citrix Cloud, the Citrix Licensing Manager Ul might
become unresponsive and display a spinning wheel. To avoid this issue, before registering your
License Server with Citrix Cloud, ensure that you have the Digicert Global Root CA certificates
installed in the system. These certificates are updated in the Windows update. If they’re not
installed, download them manually and install the certificates before starting the Citrix Cloud
registration. Also, ensure you verify firewall settings. For more information, see the Important
note under Register and remove registration with Citrix Cloud. [LIC-1510]

Fixed issues in License server version 11.17.2 build 35000

+ User/device license fails to check out with a space in the user name and displays the following
error message:

Error: checkoutOutBatch failed: Error_UNEXPECTED_DATA: Unexpected
server response 'UD: ERROR_SYNTAX'.[LIC-3506]

» The overdraft count displayed in the Citrix Licensing Manager is incorrect. In a license file
with multiple incremental lines for the same Product_Edition_Model, the Citrix Licensing Man-
ager displays the overdraft count of only the first incremental line in the license file, instead of
adding the overdraft count from all the incremental lines. [LIC-3651]

Fixed issues in License server build 34000

+ Inthe Citrix Licensing Manager > Settings > Account > User Administration section, the User-
name/Group name in the Japanese language or double-byte characters appear garbled. The
registered double-byte User/Group names cannot log on to the Citrix Licensing Manager. [LIC-
2032]

© 1999-2021 Citrix Systems, Inc. All rights reserved. 8
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Fixed issues in License server build 33000

There are no fixed issues in this build.

Known issues

September 1, 2021

Known issues in License server version 11.17.2 build 36000

There are no known issues in this release.

Known issues in License server version 11.17.2 build 35000

There are no known issues in this release.

Known issues in License server build 34000

+ In a cross-domain environment, the Citrix Licensing Manager and POSH cmdlet support only
two-way trust to add a user.

With the external trust(one-way trust), the Citrix Licensing Manager, and the POSH cmdlet displays
the following error message Active Directory account resolution failed.

Werecommend that you run the CtxManageUserAndGroup.exe from the ‘Citrix\Licensing\LS\resource’
location with the following parameters:

- Command to add a user: CtxManageUserAndGroup.exe -useradd “domain\username” -
Role “admin/user”

- Command to add a group: CtxManageUserAndGroup.exe -useradd “domain\username” -

Role “adminGroup/userGroup

Forexample, if domainl has an outgoing trust to domain2, then a user from domain2 can authenticate
in domainl and add a user to License Server using the executable only. [LIC-3268]

License file issues

+ The License Server ignores license files that have multiple lines referencing HOSTNAME=. Li-
censes in these files cannot be checked out. This issue is caused when you download licenses
associated to different License Server host names in to the same license file.

To resolve this issue, download again separate license files for each Citrix product tied to differ-
ent License Server names.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 9
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+ Licenses with expiry date incorrectly formatted as D-MMM-YYYY appear as permanent in Stu-
dio. Use the Citrix Licensing Manager to display the correct license expiration dates. [LIC-2556]

Third party notices

June 14,2021

Citrix Licensing 11.17.2 includes third party software licensed under the terms defined in the following
documents:

+ Non-Commercial Software Disclosures For FlexNet Publisher 2020 (11.17.2) (PDF download)

+ FlexNet Publisher Documentation Supplement Open Source Software Licenses applicable to
FlexNet Publisher 11.17.2 (PDF download)

License Server

September 17,2021

License Servers are computers that are partly or completely dedicated to store and manage licenses. If
you attempt to connect to a device Citrix product requests licenses from a License Server. Every Citrix
product environment must have at least one shared or dedicated License Server. Servers running
Citrix products contact the License Server to obtain licenses.

If you connect to a Citrix product, it draws licenses from the License Server. The Citrix product requests
to check out a license from the License Server on behalf of the user or client device. When the license
is checked out, you can access a product’s feature and functionality based on the license type and
edition.

Note:

Citrix ADC and Citrix Gateway do not obtain licenses from the Citrix License Server. For more

information about the product-specific licensing, see Product-specific licensing information.

The following image shows the Citrix products, License Server, Citrix Licensing Manager, and consoles
workflow:

« 1-User devices connect to a Citrix product.

« 2-Citrix products request to check out licenses from the License Server for the user or client
devices.

« 3-Citrix Licensing Manager is an administrative web interface used to manage the License
Server.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 10
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« 4-Consoles (such as Studio and Director) can connect to a License Server to monitor license use,
see alerts and other licensing configuration.
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Depending on the size and configuration of your product deployment, you might deploy licensing on

a server shared with other applications, a dedicated License Server, or multiple License Servers. For
more information, see License optimization.

License files must be on the License Server that is associated with the product you’re licensing. The
product must be configured to communicate with that specific License Server. The Citrix Licensing
Manager lets you manage and monitor your Citrix licenses by providing a user interface to the License
Server. You can view licenses and alerts, import license files, create historical usage reports, and man-
age License Server settings.

Related links

» Technical overview
+ Licensing elements
« License types

» Getting started
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Licensing elements

August 27,2021
The License Server comprises several licensing elements:

« Citrix vendor daemon

+ Options configuration file

« License request process

« Citrix Licensing Customer Experience Improvement Program (CEIP), Call Home, and compliance

The following diagram shows how Citrix products connect to the License Server.
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Citrix vendor daemon

The Citrix vendor daemon (CITRIX), a process that runs on the License Server, grants licenses. The
Citrixvendor daemon tracks the number of licenses that are checked out and which product has them.
Citrix products communicate with the Citrix vendor daemon using TCP/IP. By default, the Citrix vendor
daemon uses TCP/IP port 7279.

Options file

The options file (Citrix.opt) is a License Server configuration file. The Citrix vendor daemon reads this
file every time it restarts or receives a command to reread the file. This configuration file defines li-
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censing behavior-the number of licenses a product server can use, the location of the System Logs,
logging levels, and other user-defined customizations. The Customer Experience Improvement Pro-
gram (CEIP) and Call Home configurations are stored in this file.

License request process

When a product requests a license from the License Server, the Citrix vendor daemon determines
whether a license is available for the request.

The license request process has two phases: the product startup phase and the user connection
phase.

Product Start-Up Phase:

« When a Citrix product starts, it retrieves the License Server location from its data store.
» The product connects to the Citrix vendor daemon.
« The product checks out a startup license.

User connection phase:

« Auser connects to a computer running the Citrix product.

» The product requests a license from the License Server.

+ The Citrix vendor daemon checks to see if any licenses are available and grants or denies the
product’s request.

+ Thelicense moduleinthe product grants or denies the use of the product based on the response
from the Citrix vendor daemon.

Citrix licensing Customer Experience Improvement Program (CEIP), Call Home, and
compliance usage and analytics programs

The Citrix Licensing CEIP, Call Home, and compliance usage and analytics programs are data collec-
tion programs designed to improve your product experience and gatherimportant license compliance
information.

Citrix handles your data in accordance with the terms of your contract with Citrix, and protects it as
specified in the Citrix Services Security Exhibit available on the Citrix Trust Center.

CEIP and compliance are enabled by default during License Server installation. Call Home is volun-
tary. You can change your participation in the programs at any time by using the Citrix Licensing Man-
ager. For more information, see “Share usage statistics” under Usage and statistics.

Important

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service
Provider licenses installed, you can change the settings, but you cannot disable CEIP or Call

© 1999-2021 Citrix Systems, Inc. All rights reserved. 13
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Home. When the License Server detects Citrix Service Provider licenses, it enforces daily

uploads.

For information about configuring a proxy server, see Configure a proxy server manually in the Get
started article.

For information about command-line installation, see Use the Windows command line to install li-

censing.

Citrix Licensing Customer Experience Improvement Program (CEIP)

The CEIP program gathers configuration and usage data from your Citrix product deployment and
sends the data to Citrix once a day, based on the service start time.

Data Collected Description What We Use It For

License usage and Information about the Citrix ~ We use this data to track how

compliance data licenses installed on the licenses are consumed and
License Server, including track customer population

product ID, license type,and  compliance.
quantity, in addition to
license usage information.

License Server deployment Information about the We use this data to inform

and configuration data License Server and how it was  further development of Citrix
deployed, including license products and to improve the
server version, operating customer experience.

system version, and
configuration states.

CEIP and Call Home data elements for License Server version 11.17.2 build 35000:

Note:

From License Server version 11.17.2 build 35000 onwards data elements are listed in JSON for-

mat.

prod
DateSampleStartUTC
DateSampleStopUTC

© 1999-2021 Citrix Systems, Inc. All rights reserved. 14
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payload CLM-WSLUsage

WSLGetInventoryRequest
WSLImportLicenseRequest
list_entitlements

get_task_status
WSLGetConfigUsageSamplesRequest
WSLGetUDUploadOptionRequest
WSLGetUBScrambleOptionRequest
WSLGetSARenewalConfigOptionsRequest
WSLGetLSConfigRequest
WSLGetUsersRequest
WSLGetCEIPOptionRequest
WSLGetAlertsRequest
WSLSetConfigUsageSamplesRequest
WSLSetCEIPOptionRequest
WSLSetUBScrambleOptionRequest
WSLSetUDUploadOptionRequest
WSLSetSARenewalConfigOptionsRequest
WSLUpdateLSConfigRequest
WSLAddUserRequest
WSLModifyUserRequest
WSLRemoveUserRequest
WSLGetUpdatedLicenseDetailsRequest
WSLCheckRenewalLicensesRequest
WSLInstallRenewalLicenses
WSLGetPendinglLicenseRenewalsRequest
WSLGetHistoricallnventoryRequest
list_server_info

WSLCCRegisterRequest
WSLCCRegistrationStatusRequest

© 1999-2021 Citrix Systems, Inc. All rights reserved.
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POSH-WSLUsage

type

ver

WSLRemoveCCRegistrationRequest
WSLSetCCRegistrationPopupRequest
WSLCEIPUploadRetryRequest
WSLGetLastUploadRequest
WSLGetSupportBundleRequest
WSLGetInventoryRequest
WSLImportLicenseRequest
list_entitlements

get_task_status
WSLGetConfigUsageSamplesRequest
WSLGetSARenewalConfigOptionsRequest
WSLGetLSConfigRequest
WSLGetCEIPOptionRequest
WSLGetAlertsRequest
WSLSetConfigUsageSamplesRequest
WSLSetCEIPOptionRequest
WSLSetSARenewalConfigOptionsRequest
WSLCheckRenewalLicensesRequest
WSLlInstallRenewalLicenses
WSLGetHistoricalUsageRequestV2
list_server_info
WSLGetLicenseLocalizedNamesRequest
WSLGetUsageDetailsRequest
WSLAddUserRequest
WSLRemoveUserRequest
WSLGetUsersRequest
WSLModifyUserRequest

© 1999-2021 Citrix Systems, Inc. All rights reserved.
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LSVersion

CEIP data elements for build 32000:

License Server
Information

GUID FeaturelD

Feature

SADate StartupCounts

DateSampleStartU LPE ID

DateSampleStopUTUDBInFileCreatedUDateSampleStopUTC

DateSampleStop UDReportGenerati CountUsedMax

PortLACHTTP
PortLACHTTPS

EventlLog

Active

UDAdminUsersRel Licensees

PortLACRedirect UDAdminDevicesRe(@asrtinstalled

PortLS

PortVD

PortWSL
UDUseDomain
OptFileNoLogStat
OptFileComplianceConfig
UDUserNameCase
UDDeviceNameCase
SARenewalCheck(
EncoreSamplingPeriod
EncoreRetentionTi
EncoreEnabled
SLSProxy
SLSProxyWinAutoURL
SLSProxyWinIE
SLSProxyWinDefault
SLSProxySlsConfig

0S

Pool
CountTotal
Devices

Usage Samples
Serial
DateExpiration
Datelssued
VendorStr
Countlinstalled
CountOverdraft
Sample
Timestamp
CountInUse
OverDraft
Installed

Users

SerialNumbers

Serial
ID
SADate
SN

© 1999-2021 Citrix Systems, Inc. All rights reserved.
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License Server
Information

WindowsBuildLab
WindowsEditionID

WindowslInstallatic

WindowsProductName

WindowsDomainV
OSBits

OSLocale

VM

VMIDString
VMHVIDString
InstallUTC
ProductVersion
UpgradeFrom
SetupCluster
SGPClockErrorCoc
SGPMaxDays

SupplementalGrac

Feature

SADate

CEIP data elements for build 31000 and earlier:

GUID
DateSampleStopUTC
DateSampleStop
PortLACHTTP
PortLACHTTPS
PortLACRedirect
PortLS

PortVD

WindowsEditionID FlexeraVersion
WindowslnstallationTypeSGPClockErrorCode
WindowsProductName SGPMaxDays

WindowsDomainMembefServices

OSBits Name
OSLocale DisplayName
MemPhysMB State
CPUIDString StartType

StartupCounts

SerialNumbers

Feature ID
UDBinFileCreatedUTC
UDReportGenerationUTC
Event Log

SADate
DateSampleStartUTC
DateSampleStopUTC
CountUsedMax

© 1999-2021 Citrix Systems, Inc. All rights reserved.
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UDUseDomain

OptFileNoLogStatus
OptFileComplianceCon
UDUserNameCase

UDDeviceNameCase

PortWSL

VM
VMIDString
VMHVIDString

CPUCountLogical

DiskFreeMB
DiskTotalMB

Path Active
FirewallProfile Licensees
FirewallRule CountTotal
Profile Countlinstalled
Enabled Pool

BlockAllinboundTraffic Usage Samples

SARenewalCheckOptiol HaslPv4 DefaultinboundAction Sample

EncoreSamplingPeriod HasIPv4_DHCP DefaultOutboundAction Timestamp

EncoreRetentionTime HaslPv6 FirewallRule CountInUse
EncoreEnabled HasIPv6_DHCP Name OverDraft
SLSProxy Hardwareld Enabled Installed
SLSProxyWinAutoURL  FQDN Application LPE ID
SLSProxyWinlE PrivacySetting Protocol Count
SLSProxyWinDefault  InstallUTC LocalPorts

SLSProxySlsConfig ProductVersion Action

0s UpgradeFrom Direction

WindowsBuildLabEx SetupCluster Inventory

Citrix CallHome

Call Home is voluntary. When you opt in, Call Home performs a periodic collection of system and
product configuration, performance, errors, and more. Thisinformation is transmitted to Citrix Insight
Services once a day, based on the service start time.

You can scramble user names and device information on the License Server before it’s sent to Citrix
for processing. For more information, see Anonymize usernames through the License Server.

If you want to disable the Call Home Citrix Cloud-registered License Server upload, use the Citrix
Licensing Manager. Change your selection under Usage and statistics > Share usage statis-
tics to either Help improve Citrix products by sending detailed License Server system and
non-identifiable usage information (which does not identify users) to the Citrix Customer
Experience Improvement Program (CEIP) or Send only basic License Server system and usage
information (which does not identify users) required for license compliance purposes. You’re

© 1999-2021 Citrix Systems, Inc. All rights reserved. 19
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still registered with Citrix Cloud, but your Call Home information isn’t sent.

If you want to remove your registration, see Register and remove registration with Citrix Cloud in Usage

and statistics.

Data Collected Description

License usage and Information about the Citrix

compliance data licenses installed on the
License Server, including
product ID, license type, and
quantity, in addition to

license usage information.

License Server deployment Information about the

and configuration data License Server and how it was
deployed, including license
server version, operating
system version, and

configuration states.

Call Home data elements for build 32000:

License Server

What We Use It For

We use this data to track how
licenses are consumed and
track customer population
compliance. Registering the
License Server with Citrix
Cloud allows you to track
your usage over time in Citrix
Cloud.

We use this data to inform
further development of Citrix
products and to improve the
customer experience.

Information Feature SADate StartupCounts SerialNumbers
GUID FeaturelD DateSampleStartU LPE ID Serial
DateSampleStopUTODBInFileCreatedUDateSampleStopUTC ID
DateSampleStop UDReportGenerati CountUsedMax SADate
PortLACHTTP EventlLog Active SN
PortLACHTTPS UDAdminUsersRel Licensees

PortLACRedirect UDAdminDevicesRe(&asrtinstalled

PortLS Pool

PortVD CountTotal
CustomerID Users

OrgID Devices
PortWSL Usage Samples

© 1999-2021 Citrix Systems, Inc. All rights reserved.
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License Server

Information Feature

UDUseDomain
OptFileNoLogStatt
OptFileComplianceConfig
UDUserNameCase
UDDeviceNameCase
SARenewalCheck(
EncoreSamplingPeriod
EncoreRetentionTi
EncoreEnabled
SLSProxy
SLSProxyWinAutoURL
SLSProxyWinlE
SLSProxyWinDefault
SLSProxySlsConfig

0S

WindowsBuildLab
WindowsEditionID
Windowslnstallatic
WindowsProductName
WindowsDomainV
OSBits

OSLocale

VM

VMIDString
VMHVIDString
Hardwareld

FQDN

PrivacySetting

SADate StartupCounts

Serial
DateExpiration
Datelssued
VendorStr
Countlinstalled
CountOverdraft
Sample
Timestamp
CountlnUse
OverDraft

Installed

SerialNumbers

© 1999-2021 Citrix Systems, Inc. All rights reserved.
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License Server

Information Feature SADate StartupCounts SerialNumbers
InstallUTC

ProductVersion

UpgradeFrom

SetupCluster

SGPClockErrorCode

SGPMaxDays

SupplementalGracePeriod

Citrix Call Home data elements for build 31000 and earlier:

GUID WindowsEditionID FlexeraVersion Feature ID

DateSampleStopUTC  WindowslnstallationType&SGPClockErrorCode UDBinFileCreatedUTC

DateSampleStop WindowsProductName SGPMaxDays UDReportGenerationUTC
PortLACHTTP WindowsDomainMembefServices Event Log
PortLACHTTPS OSBits Name SADate
PortLACRedirect OSLocale DisplayName DateSampleStartUTC
PortLS MemPhysMB State DateSampleStopUTC
PortVD CPUIDString StartType CountUsedMax
UDUseDomain VM Path Active
OptFileNoLogStatus ~ VMIDString FirewallProfile Licensees
OptFileComplianceCon VMHVIDString FirewallRule CountTotal
UDUserNameCase CPUCountLogical Profile Countlinstalled
UDDeviceNameCase DiskFreeMB Enabled Pool

PortwsL DiskTotalMB BlockAllinboundTraffic Usage Samples
SARenewalCheckOptiol HaslPv4 DefaultinboundAction Sample
EncoreSamplingPeriod HasIPv4_DHCP DefaultOutboundAction Timestamp
EncoreRetentionTime HasIPv6 FirewallRule CountInUse
EncoreEnabled HasIPv6_DHCP Name OverDraft
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SLSProxy Hardwareld Enabled
SLSProxyWinAutoURL FQDN Application
SLSProxyWinlE PrivacySetting Protocol
SLSProxyWinDefault InstallUTC LocalPorts
SLSProxySlsConfig ProductVersion Action

0s UpgradeFrom Direction
WindowsBuildLabEx SetupCluster Inventory

Compliance uploads

Installed
LPE ID

Count

Installing the License Server enables the sending of compliance information to the Citrix License Man-

agement Service. Your installation of the License Server constitutes your acknowledgment of the Li-

cense Management Service and your consent to use the License Management Service. You can disable

the License Management Service anytime after installation.

For information about the Citrix License Management Service and how to disable the compliance up-

load, see Citrix License Management Service.

Data Collected Description
License usage and Information about the Citrix
compliance data licenses installed on the

License Server, including
product ID, license type, and
quantity, in addition to
license usage information.

License server system Information about the license
information server (such as Hardware ID)

Compliance data elements for build 32000:

What We Use It For

We use this data to confirm
customer compliance with
license requirements.

We use this data to identify
the License Server in the
customer’s environment.
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License Server

Information Feature SADate StartupCounts
GUID Feature ID CountUsedMax LPE ID
Hardwareld UDBinFileCreatedUTC  Serial

InstallUTC UDReportGenerationU1

UDAdminUsersReleased

UDAdminDevicesReleas

Compliance data elements for build 31000 and earlier:

GUID Feature ID Serial

Hardwareld SADate Startup Counts

Inventory CountUsedMax LPE ID
Licensing services

August 17,2021
This article contains the following information:

+ Web Services for Licensing

« Citrix License Management Service

« Citrix Licensing

« Citrix licensing Windows Management Instrumentation (WMI)

Web Services for Licensing

Studio, Director, and the Licensing Administration PowerShell Snap-in use Web Services for Licensing
to do the following:

« Communicate with the License Server and manage users
+ Allocate and install licenses
« Display License Server health, license usage, and other alert messages.

The Citrix Licensing Manager also uses it.
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Citrix License Management Service

The License Management Service enables better capacity planning and license management. This
service also helps you avoid prohibited practices:

« Duplication of licenses outside a Disaster Recovery (DR) environment
« Use of legacy licenses for new product versions
« Use of rescinded licenses

This service alerts the administrator in Citrix Insight Services about duplicate licenses in a Disaster
Recovery (DR) environment. For more information about Citrix Insight Services, see Citrix Insight Ser-

vices.

The License Management Service uses product telemetry, built into the License Server, to send data
to Citrix Insight Services. The License Management Service is not a Windows service. The first upload
occurs approximately five minutes after the License Server first starts, or restarts, and subsequent up-
loads occur once a day thereafter. The schedule resets if you reinstall the License Server. If an upload
fails, another attempt is made in 24 hours until either the upload succeeds or you disable the License
Management Service. Citrix might use uploads to help you understand and support your license envi-
ronment. See Use the command line to disable or enable the License Management Service.

Important

Your installation of the License Server constitutes your acknowledgment of the License Manage-
ment Service and your consent to use the License Management Service. You can disable the
License Management Service anytime after installation.

The License Management Service collects this information:

+ License serial numbers
 License Server GUID

« Licenses used count

« Feature name

+ Product versions

For more information about the data collected, see Compliance uploads.

Citrix Licensing

The Citrix Licensing service is the Windows service responsible for core licensing functionality. Cit-
rix Licensing services licenses to Citrix products and is responsible for managing the CITRIX vendor
daemon, license server port 27000 (by default).
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Citrix Licensing WMI

The WMl service provides access to Citrix Licensing WMI classes. There’s anamespace (ROOT\CitrixLicensing)
with a few classes (notably, Citrix_GT_License_Pool) that gives license usage and availability counts.
Querying the License Server too often (more than every 15 minutes) might impact performance
negatively.

Citrix licensing technical overview

August 17,2021

Before you can use your Citrix product, you must install Citrix licensing. Citrix licensing is a system of
components that function together. This system includes:

License server. A system that allows licenses to be shared across the network. For more information,
see License server.

License files. The files required to license your product. These files are stored on the License Server.
For more information, see License files.

Citrix Licensing Manager. The License Server management method. For more information, see Citrix
Licensing Manager.

Web Services for Licensing. Enables Studio, Director, and the Licensing Administration PowerShell
Snap-in to:

« Communicate with the License Server and manage users.
+ Allocate and install licenses.
« Display License Server health, license usage, and other alert messages.

For more information, see Licensing elements and Services.

Licensing operations overview
Check out and Check in

Typically, the first time a user connects to a Citrix product, the product requests a license from the
License Server. When the License Server grants a license request, the Citrix product reserves a license
for its use. Reserving licenses for this purpose is known as checking out licenses. When the user
logs off from the product server, the product returns the license to the License Server. This process is
known as checking in licenses. Some Citrix products check out the license when a user connects to
the product. The license remains checked out for a predetermined amount of time.
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Each time a Citrix product starts, it opens a connection to the License Server by checking out the
startup license. The startup license is a Citrix system file that enables Citrix products to maintain a
continuous connection to the License Server. For more information, see Startup license.

For example, when a server running Citrix Virtual Desktops requests a license, the product retrieves
the License Server name and port number information from the data store. The product then estab-
lishes a connection to acquire the licenses.

Note

When configuring the product-side setting for the License Server name, do not use localhost.
Though you can use the host name, IP address, or FQDN instead, Citrix recommends that you
use the FQDN.

There are three stages of the license checkout process.

 —
S — (1) 1
- e Y N Ve N\ -
=1 = \——p( = |—p | Stertuplicense
(=] (=] —
10 = = =
\_ User devices | . Citrix product ’ License Server ’
S e 2) " server J e 3) \ / 2%
N —_— S e — Nl \\Produc‘c licenses
A

A Citrix product goes through a three-step process to check out licenses:

1. Atstartup, a computer running a Citrix product checks out a startup license.
2. Aclient device connects to the product server.
3. The product requests a license from the License Server.

Citrix products, such as Citrix Virtual Desktops, stores a replica of the licensing information from the Li-
cense Server, including the number and type of licenses. If a Citrix product server loses its connection
to the License Server, or the License Server does not respond in a timely manner, the product enters
a grace period. During the grace period, the product uses its local record of the licenses to continue
licensing the product. After communication is re-established between the product and the License
Server, the grace period is reset.

Scalability

This section provides guidance to ensure successful License Server usage by examining the impact of
license usage scalability in a Citrix environment. We performed this scalability testing:

Virtual Machine Hardware/Configuration:
Intel Xeon E5-2650 v3 @ 2.30 GHz
4 Virtual CPUs
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8 GB RAM
Windows Server 2016

6.5 and earlier Concurrent:

+ 3000 connected Citrix Virtual Apps servers
« 53,000 concurrent licenses
« 50-60 connections per second

Efforts to scale more than 53,000 licenses result in servers going into a grace period. Also, there are is-
sues with WMI and Imstat. We recommend that you maintain 50,000 or fewer concurrent connections
per License Server.

7.x Concurrent:

+ 16 Delivery Controllers
+ 70,000 concurrent licenses
» 50-60 checkouts per second

7.x User/Device:

+ 16 Delivery Controllers
+ 150,000 user/device licenses
» 50/60 checkouts per second

CITRIX.exe is a single threaded process. While it’s serving Concurrent connections, the maximum
connection limit is based on the single core processor speed. During peak activity, CITRIX.exe uses
100% of a single core and eventually starts timing out. This usage might cause Citrix products to go
into a grace period or errors in the License Server utilities. After the License Server has processed
backlog connections, it returns to normal. Monitor the CITRIX.exe processor usage to determine if a
faster processoris required. We recommend if you experienceissues in high scalability environments,
you deploy more License Servers.

User/Device technology is multi-threaded and scales better than Concurrent. During license optimiza-
tions, you might see that periods were licensing activity takes 100% of a single core. This usage is
normal and doesn’t impact the CITRIX.exe processor usage or functionality. We recommend that you
monitor License Server resource usage and add more License Servers to maintain a properly function-
ing environment.

Note

Running WMI, lmstat, lmutil, or other inventory actions can negatively impact the License
Server performance. We recommend that you minimize these activities. If you require usage
data, export the data from the Citrix Licensing Manager. For more information, see Historical
Use.
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License Server using different product editions

One License Server can contain licenses for multiple editions of a Citrix product. For more informa-
tion about product editions, see Citrix Products and License Models. The type of license checked out
corresponds to the edition that is configured on the product server. A product server is configured to
consume a specific edition of a license and checks out that license edition.

For example, ProductServerA is configured to check out Advanced licenses. ProductServerB is config-
ured to check out Premium licenses. LicenseServerl contains both Advanced and Premium licenses.

+ Users who connect to ProductServerA, which is configured to use licenses installed on Licens-
eServerl check out Advanced licenses only. After the number of Advanced licenses on Licens-
eServerl is exceeded, new requests from ProductServerA users are denied until existing Ad-
vanced connection licenses are released.

+ Users who connect to ProductServerB, which is configured to use licenses installed on
LicenseServerl check out Premium licenses only. If the number of Premium licenses on Li-
censeServerl is exceeded, new requests from ProductServerB users are denied until Premium
connection licenses are released.

Note:

License checkout times mightincrease if many product servers that have many users are contact-
ing the same License Server simultaneously. One License Server can accept only 10,000 inbound
TCP/IP requests at one time. If you are planning to have more than 10,000 Citrix product servers
connecting at the same time, we recommend that you use several License Servers. These prod-
uct servers can include Citrix Virtual Apps and Desktops, Delivery Controllers, and Appliances.

Deployment examples

Scenario 1: Two sites

« SiteA contains product servers configured for the Advanced edition.
« SiteB contains product servers configured for the Premium edition.
« One License Server (shared).

« Userl, User2, User3, User4...User5000 connect only to SiteA.

» User5001, User5002, User5003...User10000 connect only to SiteB.

Scenario 2: One site

 The site has two sets of published applications.

+ The site is configured as Citrix Virtual Apps and Desktops Premium concurrent and Delivery
Groups 2 as Citrix Virtual Apps and Desktops user/device

« One License Server (shared).

« Userl, User2, User3, User4...User5000 connect only to the concurrent licenses.
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« User5001, User5002, User5003...Userl0000 connect only to Delivery Group 2 user/device
licenses.

Licensing concepts

Grace period
Note:

The grace period and supplemental grace period are two different features. For more informa-
tion about the supplemental grace period, see Supplemental grace period.

If product servers lose communication with the License Server, the users and the products are pro-
tected by a grace period. The grace period allows the product servers to continue operations as if
they were still communicating with the License Server. After the Citrix product checks out a startup
license, the product and the License Server exchange heartbeat messages every five minutes. The
heartbeat indicates to each that they are still up and running. If the product and the License Server
don’t send or receive heartbeats, the product lapses into the licensing grace period and licenses itself
through the cached information.

Citrix sets the grace period. It is typically 30 days but can vary depending upon the product. The
Windows Event Log, and other in-product messages, indicate if the product has entered the grace
period, the number of hours remaining in the grace period. If the grace period runs out, the product
stops accepting connections. After communication is re-established between the product and the
License Server, the grace period is reset.

The grace period takes place only if the product has successfully communicated with the License
Server at least once.

For concurrent licenses, they can connect up to the maximum concurrent licenses installed. For
user/device licenses, they have unlimited connections.

Grace period example - two sites, both using the same License Server

+ The connection between Site 1 and the License Server goes down causing Site 1 to go into the
grace period, continuing operation and making connections.

« When Site 1 reestablishes communication with the License Server, connections are reconciled
and no new connections are allowed until they are within normal license limits.

« Site2 is unaffected and operates as normal.

« If the License Server goes down, both sites go into the grace period. Each site allows up to the
maximum number of licenses installed. As above, the user/device licenses have no limit.
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New licenses

+ New licenses are the licenses you purchased from Citrix within the last 30 days.
« The new licenses section displays the top five recent purchases.
+ New licenses are indicated with a green bar and the word (New) in green.

I () Citrix virtual Apps and Desktops Premium Edition {New}

+ You can Allocate licenses from the landing page only for new licenses. Select the required li-
cense and start the allocation process by clicking Allocate licenses.

Expiring term licenses

« Expiring licenses are term licenses that are expiring within 90 days.
+ Licenses expiring within 0 through 30 days are displayed with a red bar. Licenses expiring within

31 through 90 days are displayed with an orange bar.

Expiring term licenses
Product name Licerse aioess code = Aiocated Expires

+ The Expires column shows the number of days until the license expiry date.
« The Allocated column shows the allocated quantity and total purchased quantity.
+ The expiring licenses section shows the 5 most recent purchases.

Glossary

Allocate licenses: When you allocate licenses, you apportion purchased licenses by product and Li-
cense Server so you can split them among multiple environments or use cases. For example, your
organization might own 1,000 licenses for the same product. You might want to use 800 in 1 location
and 200 in another location. You can allocate 800 licenses to a License Server in the first location
today, and allocate the remaining 200 later to a different License Server.

Asset components: Asset components are the license details.
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CSV files: The Excel CSV file provides daily usage information, including the number of licenses in
overdraft.

Modify licenses: Choosing to modify licenses, returns the license file and allocates it to another Li-
cense Server.

Return allocations: When you Return licenses, you put the licenses back in the licensing pool. You
can then allocate these licenses in any quantity at any time. After you return a license, remove the old
license file from the License Server.

Term licenses: Term licenses are purchased for a specified amount of time and have an expiration
date.

License files

August 17,2021
Before you start installing product licenses, see the prerequisites to obtain your license files.

When you install the License Server, a Citrix start-up license (citrix_startup.lic) and an options file (CIT-
RIX.opt) are installed by default. To license your Citrix products, you add one or more license files. For
information about adding your product licenses, see Install licenses.

You cannot change the location of license files on the License Server. License files must reside in their
default location.

Citrix Start-up license

The start-up license file (citrix_startup.lic) is a text file that Citrix products use to communicate to the
License Server using a continuous open connection. Every five minutes the License Server and the
product send a heartbeat message to each other to verify that they are mutually communicating.
When the product and License Server exchange heartbeat messages and there is an interruption in
the exchange, the product goes into a grace period. A power failure is an example of an interruption.
The startup license file does not affect your license count.

Citrix License Server Diagnostics License

The License Server uses Citrix License Server Diagnostics License for internal diagnostics and alert
message notifications displayed in Citrix Studio and Director. Itis available by default with the startup
licenseinthe citrix\\_startup.licfile.
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Warning

Do not edit the startup license file, or any other license files.

License file

The license file is a text file containing the following:

+ Product licensing information

+ License Server name (or other binding identifier)

« Customer Success Services membership renewal date (also known as the Customer Success
Services expiration date)

« License expiration date (if applicable)

« Other system information

All this information is encrypted using a digital signature. When you purchase a Citrix product, go to
the citrix.com website to download a license file. For more information, see Manage licenses on
Citrix.com. You can have more than one license file per License Server. The license file resides in these
directories, where the License Server references it.

« C:\Program Files\Citrix\Licensing\MyFiles directory on a 32-bit server
+ C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server

The License Server uses this file to determine whether to grant a license to a Citrix product.

A license overdraft is included in all user/device, per user, and per device licenses. For more informa-
tion on the license overdraft, see License overdraft.

Move licenses to a different host

The license file you downloaded for the old License Server cannot be moved to a server that has a dif-
ferent host name or MAC address. Create license files that reference the new server name by returning
them and then allocating them.

For more information, see Modify licenses.

License file format
Important

Any changes to the license file can make license files unusable. If using Citrix Licensing for Win-
dows 11.6.1 or later, editing license files is not necessary. You can manage licenses through the
Citrix Licensing Manager and the My Account site at citrix.com. For more information, see
Manage licenses in MyAccount on citrix.com.
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You can change the name of the license file, but it must have a .lic (lower case) extension.
Citrix license files use the following naming convention:

FID_fulfillmentID.1l1ic

For example: FID_30d0000_0000_xxxx_c800_00xxyy000zz7.lic

License files are composed of lines listing specific information, such as the server name (SERVER) or
quantity of licenses (INCREMENT). These lines begin by using words denoting their purpose in upper-
case letters, such as VENDOR, SERVER, INCREMENT, USE_SERVER.

The following sections provide in-depth information about the following elements of license file syn-
tax: the SERVER line, VENDOR line, USE_SERVER line, and INCREMENT line.

The following image is an example license file:

SERVER line shows an identifier required for binding licenses to the License Server.

VENDOR line specifies the Citrix vendor daemon name.

INCREMENT lines specifies the license required to use a product.

Comments used by the License Serverto translate license FEATURES (PRODUCT_EDITION_LICENSEMODEL)
to Citrix product names.

> w e

# This file is in UTF-B format

# ~

SERVER this_host HOSTNAME=license_server! (1)

VENDOR CITRIX (2) )

USE_SERVER

INCREMENT MPS_ENT_CCU CITRIX 2006.0428 01-may-2005 1000 \ (3)
VENDOR_STRING=; LT=Retail, GP=720,CL=ENT ADV 5TD;SA=0,0DP=0\ | —
DUP_GROUP=Y ISSUED=12-Mar-2004 NOTICE="eMail Test - Citrix" \
SN=LA-0000150712-86261:872 START=11-mar-2004 SIGN="0885 F320 \
DAE2 EE72 BBA4 92FC 8502 3648 A2CF 346D ABBF BD44 TS1114
D790 1830 7535 553C B774 DEBC 1F5D A5D3 DSF6 D078 2176 BHO50 \

A14C 2893 7756 ACF5"
# Py
#English] (4)
#CITRIXTERM FEATURE 20 MPS_STD_CCU EN Citrix Presentation Server Standard|Concurrent User
#CITRIXTERM FEATURE 20 MPS_ADY CCU EN Citrix Presentation Server Advanced|Concurrent User
H#CITRIXTERM FEATURE 20 MPS_ENT_CCU EN Citrix Presentation Server Enterprise|Concurrent User
#
SERVER Line

The SERVER line specifies the binding identifier (also known as the host name) of the License Server.
Caution:
Do not change the binding identifier on the SERVER line otherwise, the license file doesn’t work.
Syntax:
SERVER this_host ether

Or
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SERVER this_host HOSTNAME=hostname

Parameters Description

ether The MAC address of the appliance on which the
License Server is running. Do not edit this text
string.

hostname The name of the computer on which the

License Server is running. Do not edit this text
string.

Example

SERVER this_host HOSTNAME=1l1icense_serverl

VENDOR Line
The VENDOR line specifies the Citrix vendor daemon name.

Syntax:

VENDOR CITRIX [vendor_daemon_path]

Field Description

VENDOR CITRIX Name of the Citrix vendor daemon. Do not edit
this name.

vendor_daemon_path Path to the executable for the Citrix vendor

daemon. Citrix recommends that you do not
change this path.

INCREMENT Lines

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or
more INCREMENT lines. Each INCREMENT line makes up a user-specified allocation of product and

license (users, connections) counts.
Each increment line contains:

« Asignature based on the data in that line
« The hostids specified in one or more SERVER lines
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« Data selected by Citrix
INCREMENT lines use a backslash () to wrap long lines of text.
Syntax:

INCREMENT feature vendor css_expiry_date exp_date num_lic
SIGN=sign [optional_attributes]

Caution:

Do not change the six fields after the INCREMENT line keyword. The fields are required and have
a fixed order.

The following table explains these fields in the order they appear:

Field Description
feature The product license. Do not edit this line.
vendor Indicates that this license is for a Citrix vendor

daemon. Do not edit this line.

CSS_expiry_date Indicates the date until which you are entitled
to product version upgrades. If you don’t have
a Customer Success Services membership, or
this license isn’t a Customer Success Services
license, the date indicates when you ordered
or redeemed the license. Do not edit this line.
Note: If you renewed your Customer Success
Services membership and received an upgrade
license, the CSS_expiry_date is listed. For
example: INCREMENT MPS_ENT_CCU CITRIX
2019.0311 permanent 1000 \

exp_date Expiration date of license in the format
dd-mmm-yyyy, that is, 07-may-2006. Do not
edit this line. Note: If the exp_date field
contains the text string permanent, the license
never expires.

num_lic Number of concurrent licenses for this product
license. Do not edit this line.

SIGN=sign SIGN=signature to authenticate this
INCREMENT line. Do not edit this line.
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Field Description

SUPERSEDE_SIGN=sign Strategically turns off specific licenses based
on license feature and signature or INCREMENT
line to be disabled. Customer Success Services
or maintenance upgrade licenses include
SUPERSEDE_SIGN. Example:
SUPERSEDE_SIGN={“CBR_100_SSERVER:0F76
2946 4790 6B67 08E0 65BC 302B E1B6 6ECE
41D6 8AB6 EOC6 FE44 4EB3 9A83 01E4 D405
3E95 74B8 9BC8 7791 BDD3 1385 33F8 9533
95FF A3E4 F461 35B4 251E”}

INCREMENT lines also determine the grouping of licenses in the management console. These groups
are known as license pools. The Citrix vendor daemon creates the license pools based on common
attributes, such as product license or version. The console displays and tracks a newly created pool
independently from other license pools. The Citrix vendor daemon creates a license pool when two
or more attributes are different.

Citrix Attributes in INCREMENT Lines:

INCREMENT lines can also include more attributes from Citrix. These attributes provide information
about the license, such as the date of issue or if the license is an upgrade license.

Caution:

Do not change or remove these attributes.
Example:

INCREMENT rP5_ENT_CCU CITRIX 2008.0606 permanent 10 Y,
WVENDOR_STRING=;LT=Retail;GP=720;CL=ENT,ADV,5TD,AST;SA=1;0DP=0"% DUP_GROUP=V
ISSUED=06-Jun-2007 NOTICE="Citrix" \ SN=12345:67890 5TART=6-Jun-2007 SIGHN="18F8 1546
Fo05 E3BD 010E 7E4F A4B3 9DE3 BOOE 7937 3337 0180 1FFB CoAER D491”

Important items are highlighted in the preceding example:

« The Product (license feature) appears in blue
« The Customer Success Services expiration date appears in red (Format: YYYY.MMDD)
+ The License (user, connection) count appears in GREEN

Syntax:

keyword=value
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The following table describes the Citrix attributes. The uppercase letters of the attributes indicate that

this attribute is not editable.

Attribute

DUP_GROUP=V

ISSUED=dd-mmm-yyyy
ISSUER="...”
NOTICE="..

SN=serial_num

START=dd-mmm-yyyy

SUPERSEDE="MPS_ADV_CCU MPS_STD_CCU

»

VENDOR_STRING="...”

Example of a base license:

Description

This attribute allows license sharing for the
same client device.

Date issued.
Issuer of the license.
Your company name.

Serial number is the License Access Code and
the fulfillment ID of that license.

The date from which you can start using a
license. The License Server cannot use licenses
before their start date. You can install licenses
before the START date but there are not visible
in your License Server inventory until the
actual START date.

This attribute appears in the upgrade license
file when you move to a higher product edition.
If this attribute appears, this line supersedes
all licenses issued before the date specified in
ISSUED= and they become ineffective.

Text string defined by Citrix.

INCREMENT CBR\_100\_SSERVER CITRIX 2016.1201 permanent 10 \\

VENDOR\ _STRING=;LT=Retail;GP=720;MAXBW=1;MLC=0;HA=0;CL=BRSE ;SA=1;0DP

=0 \\

DUP\_GROUP=V ISSUED=18-dec-2005 NOTICE="Citrix" \\

SN=100se200seB SIGN="1B19 C213 7517 CC62 756F 864C 9C93 O6FC \\

E1DE B5D5 D793"
<!--NeedCopy-->

Example of a Customer Success Services renewal license containing SUPERSEDE_SIGN:
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INCREMENT CBR\_100\_SSERVER CITRIX 2017.1201 permanent 10 \\

VENDOR\_STRING=;LT=Retail;GP=720;MAXBW=2;MLC=0;HA=0;CL=BRSE ;SA=1;0DP
=0 \\

DUP\_GROUP=V ISSUED=18-dec-2007 NOTICE="Citrix" \\

SN=100se200seU SUPERSEDE\_SIGN={
"CBR\_100\_SSERVER:1B19 C213 7517 \\

CC62 756F 864C 9C93 O6FC E1DE B5D5 D793" }
SIGN="1D5D 869A 40BE \\

D4DB 361D 7897 AFA5 FF8B E52A 20BA 5525 01AA F241 6919
<!--NeedCopy-->

License types

September 8, 2021

Your Citrix product uses one of the license types described in this document. Some products allow
you to select more than one type of license. Ensure that you are aware of the licenses that are pur-
chased and how they are consumed. Some license types offer license overdraft and supplemental
grace period as a feature.

The Citrix License Server supports any Citrix products that require Citrix licenses. For more informa-
tion, see Products and license models.

User/device license
Overview

In user/device type licensing the License Server dynamically assigns a license to a user or a device
based on the usage and monitors license consumption. The default assignment is a user license. The
license server considers each connection and its optimization engine. It ensures that the smallest
number of licenses are used based on the userID and devicelD.

The license server truncates domains by default so that eng@abc.com and citrite@abc.com are
treated as a same user. For more information, see Disable the domain name truncation.
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Note:

Do not join the license server to any of the domains its hosting licenses for.

Scenarios

« When alicense s assigned to a user. A user license allows the user to access from an unlimited
number of devices. A licensed user requires a unique user ID, such as an Active Directory entry.

For example, the user can connect to their desktops and applications using multiple devices such as
desktop, laptop, smartphone, or thin client. Alicensed user can connect to multiple instances of Citrix
Virtual Desktops concurrently.

+ When a license is assigned to a device. A device license is assigned to a device when two or
more users connect to an exclusively shared endpoint device.

For example, single shared devices such as a kiosk or a workstation in a call center environment used
by multiple users.

The following table illustrates how user/device licenses are assigned to non-shared devices and exclu-
sively shared devices. Blue color cells display user licenses, where the devices are not shared. Green
color cells display device licenses, where the devices are exclusively shared.

Devices/Users John Rose @ Joe Roy Tom Karen Rick @ Tony
Laptop X X

PC X

Mobiles X X X X

Laptop2 X X

PC1 X

Desktop1 X X X X

Desktop?2 X X

License assignment period

When users or devices connect to an application or desktop, they consume a license for a 90 day as-
signment period. The license assignment period begins when a connection is established. The period
is renewed to a full 90 day during the life of the connection. The user/device lease for the license as-
signment will expire in 90 days after the last connected user or device disconnects.
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Release licenses for users or devices

You can release a license for a user only when:

« The employee is no longer associated with the company.
« The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

License optimization

The License Server uses the optimization process to determine how to minimize license consumption.
This optimizationis based on licenses in use and connections to the License Server. The License Server
optimizes every five seconds until there are 5000 unique connections. Connections at 5000 and above
optimization occurs every five minutes. Optimization might delay status information until the next
optimization, impacting when license usage statistics are updated in various consoles.

Optimization occurs every five seconds for 1-4999 uses and every five minutes for 5000 or more uses.

Optimization is not consumption. The following table is the example of connections and optimization
time when optimization occurs.

Device and user connection Optimization time

700 users * 1 device each 700 (optimize every 5 seconds)

5000 users * 1 device each 5000 (optimize every five minutes)

5000 devices * 1 user each 5000 (optimize every five minutes)

2500 users * 2 devices each 5000 (optimize every five minutes)
Note:

« If you have a large deployment, optimization can be CPU intensive depending on the num-
ber of unique connections. We recommend using machines with multiple cores.

+ Customers hosting many license servers or shared disk systems see high read and write op-
erations. Evenifallthe license servers have less than 5000 users, each would optimize every
5 seconds and write cache data to disk. You cannot disable the optimization or change its

frequency.
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Concurrent license
Overview

Concurrent license is not tied to a specific userID, Active Directory account, or a domain. Concurrent
licensing is based on the originating endpoint devicelD. A user or endpoint device could connect to
multiple sessions and use a single license.

You start a product that requests a license and it is checked out to a unique endpoint devicelD. When
you log off or disconnect from the session, the license is checked in and is available for a new user.
Note, we don’t license per session.

Scenarios

« Multiple sessions at different computers use multiple licenses. Each time you start a Citrix
session from various devices, a license is checked out until you close that session. At that point,
the license is checked back in.

For example, a user starts a session from one computer and then starts another from a different
computer before closing the first session. Two licenses are checked out.

« License Servers do not communicate with each other. If you run multiple License Servers,
you might consume more than one license (for example, with load balancing). If you are using
load balancing, we recommend that the product servers point to the same License Server.

- Different editions consume different licenses. Two licenses are consumed, if you use the
same client to connect to applications running on an Advanced edition and Premium edition
each.

+ Same product, edition, and license model consume single license. If you make multiple
connections from a single device to different product servers configured with same edition and
license model and pointing to the same License Server. Only one license is consumed.

« For license sharing, pass-through connections on Citrix Virtual Apps and Desktops pass
the endpoint client device ID to the product server. If you connect to a single product, edi-
tion, and license model with a shared License Server, all connections share a single license.

+ A user connects from a single device to two product servers that are the same edition but dif-
ferent versions. One or two licenses might be consumed based on the order in which the user
makes the connections.

For example, the two servers are Citrix Virtual Apps and Desktops 7 1811 and Citrix Virtual Apps
and Desktops 7 1903:

- The user connects to Citrix Virtual Apps and Desktops 7 1811 first. Two licenses might
be consumed. An older license first, for the older product, and then a newer license be-
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cause version 1903 requires a newer Customer Success Services date. For more informa-
tion, see Customer Success Services.

- The user connects to Citrix Virtual Apps and Desktops 7 1903 first. Only one license is
consumed because the Customer Success Services date required by version 1903 is com-
patible with all older product versions.

- If the Customer Success Service date of all the installed licenses are compatible with all
the product versions then a single license is required for each connecting device.

« RDP connections consume a license but RDP connections to a console do not consume a license.

« If the number of connections exceed the purchased and available standalone concurrent li-
censes, users are denied access unless the supplemental grace period is enabled. For more
information, see Supplemental grace period.

Per user license
Overview

Alicensed user requires a unique user ID, such as an Active Directory entry. When a license is assigned
to a user, the license allows the user to connect to their desktops and applications using multiple
devices. A User license is assigned to the User and not to the User’s devices.

Note:

These licenses are only user licenses and are not the same as user/device licenses.

Scenario

« A user can connect to multiple devices such as desktop computer, laptop, netbook, smart-
phone, or thin client. A licensed user can connect to multiple instances of Citrix Virtual Desktops
concurrently.

License assignhment period

When a user connects to multiple devices, a user license is consumed for the 90 day assignment pe-
riod. The license assignment period begins when a connection is made. The period is renewed to the
full 90 days during the life of the connection. The device lease for the license assignment will expire
in 90 days after the last connected user or device disconnects.

Release licenses for users or devices

You can release a license for a user only when:

« The employee is no longer associated with the company.
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« The employee is on an extended leave of absence.
You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

Per device license
Overview

A licensed device requires a unique device ID and any individuals can access instances of a product.
It allows an unlimited number of users per device. A single Device license can support multiple users
from the same device.

Note:

These licenses are only device licenses and are not the same as user/device licenses.

Scenarios

+ Aclassroom workstation, used by many students.
« Aclinical workstation in a hospital, used by hospital staff.

License assignment period

When asingle device is used by multiple users, a device license is consumed for the 90 day assignment
period. The license assignment period begins when a connection is made. The device lease for the
license assignment will expire in 90 days after the last connected user or device disconnects.

Release licenses for users or devices

You can release a license for a user only when:

« The employee is no longer associated with the company.
« The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

Per socket license

Per socket licenses are consumed based on the number of CPU sockets. Cores are not counted. For
example:

« If a computer with two CPU sockets has only one CPU then only one license is consumed.
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« If acomputer with two sockets has two CPUs, each with a quad core, then two licenses are used.

Citrix Hypervisor uses per socket licenses.

Named user license (legacy)

In a product when you request a license, a named user license is checked out until a preconfigured
period expires. This type of license check-out is not tied to a computer or a device. After the license
is checked out, the user can run multiple sessions on different computers without checking out more
licenses.

License overdraft

On-premises products that support user/device, user, or device license models include a license over-
draft feature. This feature enables you to use an additional 10% of extra licenses beyond the pur-
chased quantity to prevent access denial. The license overdraft count is displayed in a separate col-
umn within the License Administration Console. The installed column displays both the purchased
license total plus the associated overdraft total. Overdraft usage is also visible in Studio.

The license overdraft feature is offered as a convenience, not as a license entitlement. Any overdraft
licenses used must be purchased within 30 days of first use.

Concurrent licenses and server licenses do not contain the overdraft feature. Citrix reserves the right
to remove any overdraft feature in new product releases.

Supplemental grace period

The supplemental grace period enables unlimited connections to a product for 15 consecutive days.
This feature is available to Citrix Virtual Apps and Desktops licenses. You can use this feature with a
XenApp 7.6 or XenDesktop 7.6 version and above.

If all licenses are in use, including the license overdraft where applicable, the supplemental grace
period gives you time to determine why you exceeded the maximum license count and to purchase
more licenses without disrupting your users.

After the supplemental grace period expires, normal connection limits are enforced. Users are not
disconnected during active sessions. As they disconnect, however, no new connections can occur
until the license levels return to normal.

The supplemental grace period is not automatically re-enabled once it completes. To re-enable the
supplemental grace period, you must install another retail license, which grants a new 15-day supple-
mental grace period if and when you exceed the subsequent maximum installed licenses limit.
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We recommend that you allow the supplemental grace period to run out after it starts. To clear the
warning condition do not add licenses immediately. Doing so gives you time to fully assess the situa-
tion and correctly address any issues.

Note:

If you install licenses while the supplemental grace period is in force, the License Server exits the
supplemental grace period. Reenabling the supplemental grace period before fully determining
the reason for the supplemental grace period, and how many licenses you require, might cause
you to reenter the period after installing new licenses.

Supplemental grace periods are granted per product version and edition and only for retail li-
censes. The supplemental grace period is enabled by default when you first install the licenses. To
disable the supplemental grace period feature, use the Citrix Licensing Manager.

There is no way to track the total number of licenses consumed while in the supplemental grace pe-
riod. You can use lmstat udadmin and connection information from the product to determine how
many additional licenses are required.

Note:
The grace period and supplemental grace period are two different features.
The grace period and supplemental grace period features do not apply when licenses expire.

For more information about grace periods, see Grace period.

Citrix Virtual Apps and Desktops Director displays the grace period states. For more information, see
Panels on the Director Dashboard.

The supplemental grace period feature is offered as a convenience, not as a license entitlement. Citrix
reserves the right to remove any such feature in new product releases.

Overdraft and Supplemental grace period examples

Example 1: Citrix Virtual Apps and Desktops user/device, user, or device licenses using the overdraft
and supplemental grace period features

1000 @ 1000 41 @ 1000 I . 1000

do d10 d25

SGP

~
r

Time

You initially purchase and install 1000 licenses from Citrix () which includes a 10% license overdraft al-
lowance (OD). When licenses are allocated, you’ll have 1100 licenses in total. At the time it is sufficient
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for the number of users connecting.

do At a later date (day 0) you are using 1050 licenses. When the 1001st license was used, the overdraft
feature was activated. Your users can continue to connect without any disruption of service. You start
evaluating your licensing needs now. Do not wait until you exceed the OD. Think about buying more
licenses in addition to the 1000 you bought initially.

d10 10 days later (day 10) more users connect and 1150 licenses are being used, which exceeds the
1100 total licenses you have available (!). When the 1101st license was used, the 15 day supplemental
grace period (SPG) started, to allow you time to evaluate your license needs. Your users can continue
to connect without any disruption of service.

d25 15 days later after d10 (day 25) the supplemental grace period runs out because you chose not
to purchase and install more licenses. Users cannot make new connections if doing so requires more
than 1100 licenses to be checked out. You cannot re-enable the supplemental grace period until you
purchase and install more licenses.

Example 2: Citrix Virtual Apps and Desktops concurrent licenses using supplemental grace period
feature

SGP

do d15 Time
You initially purchase and install 1000 concurrent licenses (1). There is no overdraft allowance with
concurrent licenses. At the time these licenses are sufficient for the number of users connecting.

do At a later date (day 0) you are using 1050 licenses. When the 1001st license was used, the 15 day
supplemental grace period (SPG) started, to allow you time to evaluate your license needs. Your users
can continue to connect without any disruption of service. You start evaluating your licensing needs
now. Do not wait until the supplemental grace period runs out. Think about buying more licenses in
addition to the 1000 you bought initially.

d15 15 days later (day 15) the supplemental grace period runs out because you chose not to purchase
and install more licenses. Users cannot make new connections if doing so requires more than 1000
licenses to be checked out. You cannot re-enable the supplemental grace period until you purchase
and install more licenses.

Overdraft and supplemental grace period availability

The following table lists the support for license overdraft and supplemental grace period for each prod-
uct. For more information, see Products and license models.
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Supplemental Grace

On-premises product  License type 10% Overdraft Period (15 days)
Citrix Virtual Apps User/device, User, Yes Yes

and Desktops Device

Citrix Virtual Apps Concurrent No Yes

and Desktops

XenMobile Server User, Device Yes No

Citrix on-premises subscription for annual and term-based retail licenses

On-premises subscription licensing allows customers to host a Citrix environment within their infras-
tructure for a set period. The on-premises subscription license is time bound for 1-5 years and expires
on a specific date. The license ceases to operate following the expiration date. The products offer
everything that is available today with perpetual licenses.

Your purchase includes both an on-premises subscription license and Customer Success Services Se-
lect service. Customer Success Select service is included for the entire term of the subscription.

Note:

Mixing permanent (perpetual) and subscription licenses is supported. They can be used to
expand existing environments provided customers use the same product, edition, and license
model. There are no performance impacts to using perpetual vs. subscription licenses. The

only difference between them is one expires.

Before license expiration

For products that are automatically renewed each month, Citrix does not send notifications before
expiration.

For products that are not automatically renewed, Citrix notifies you at certain intervals when your
existing subscription approaches expiration. These notifications alert you to extend the subscription
and avoid service interruption.

All on-premises subscription, annual and other term-based retail licenses include an additional 30
days built into the expiration date for continued access. These additional 30 days are included in
the expiration date shown in the Citrix Licensing Manager. You can use these 30 days to repurchase
subscription licenses, allocate, and install before the original subscription license expires. If you do
not renew, the product gets into an unlicensed state with limited capabilities.

Example: If you purchased a one year on-premises subscription license on 21 Oct 2020, your license
will expire at 12:01 on 22 Nov 2021.
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When your on-premises subscription expires, as per the date listed in the Citrix Licensing Manager, no
new connections are allowed. Existing users are not impacted, however, if users log off or disconnect
they are not allowed to reconnect.

Extend on-premises subscription licenses

The Citrix Auto-Renewal program is the default renewal program for all on-premises subscription
licenses. On-premises subscriptions licenses are enrolled in the Auto-Renewal program. To learn
more about the Auto-Renewal Program visit https://www.citrix.com/buy/licensing/citrix-cloud-
services-renewals.html.

To extend your on-premises license subscriptions, visit https://www.citrix.com/buy/.
Note:

Licenses with a future start date are not displayed in the License Server inventory until the actual
start date mentioned in the license file.

FAQs

« Will on-premises subscription licenses work with existing perpetual licenses on the same
server?

Yes, within the guidelines of existing license server operation. Customers must add a new term
license file to the license server.

Term or subscription licensing does not have a negative impact on delivering the on-premises
subscription licenses to a customer’s existing environment, provided the product version
(Virtual Apps / Virtual Apps and Desktops), edition (Standard, Advanced, Premium), and type
(User/Device, Concurrent) are the same. For example:

- Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Premium Concurrent term will have no issues.

- Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Premium User/Device term. This license combination is non-standard and requires con-
sideration and additional configuration. This combination may not be optimal for license
utilization.

- Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Advanced User/Device term. This license combination is non-standard and not advisable.
Requires customer to have multiple sites or farms to use all purchased licenses.

« Will the XenApp farm, Citrix Virtual Apps, Citrix Virtual Apps & Desktops stop accepting
connections?
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Yes. No new connections are allowed after the license expires. Existing connections would not
be impacted until users disconnect, logoff, or reset.

+ Willthere be a supplemental grace period (SGP) of 15 days or does that only apply to per-
petual licenses?

No. There is no grace period for license expiration. An extra month is added into the expiration
date for customers to install repurchased licenses.

Transition and Trade-Up (TTU) with Hybrid Rights

September 29, 2021

Transition and Trade-Up

« Transition is when you move your current on-premises licenses to the cloud version of the same
product/edition. For example, you move from Citrix Virtual Apps and Desktops Advanced on-
premises to Citrix Virtual Apps and Desktops Advanced Service.

+ Trade Up is when you exchange your current on-premises licenses or cloud subscriptions to a
new product or a higher-level product edition. For example, you move from Citrix Virtual Apps
and Desktops Advanced on-premises to Citrix Virtual Apps and Desktops Premium Service.

« Transition and Trade-Up (TTU) is a combination of both Transition and Trade-up where you
move your current on-premises licenses to the cloud and exchange these licenses for a higher-
level product edition. For example, you move from Citrix Virtual Apps and Desktops Advanced
on-premises to Citrix Workspace service Premium Plus.

An on-premises customer can move their existing deployments of eligible Citrix products to Citrix
Cloud services through the Transition and Trade-Up (TTU). TTU subscriptions are co-termed with Hy-
brid Rights for easy transition process. Hybrid-Rights provide time to gradually move on-premises
deployments to Cloud while accessing both on-premises and Cloud environments during such period.

Transition and Trade-Up terms and limitations

+ You must have a minimum of 25 licenses in your account.

« You must have an active Customer Success Services entitlement in effect at the time of your
Transition, Trade Up, or TTU transaction.

« The on-premises licenses which are the subject of the Transition, Trade-Up, or TTU are re-
scinded upon the purchase. The rescinded licenses are replaced with term-based on-premises
licenses corresponding to the licensing product, edition, and model of the original on-premises
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licenses. Those on-premises entitlements under Hybrid Rights are delivered under the li-
censing product, edition, and model of the original on-premises licenses and not the new
subscriptions. For more information see Hybrid Rights.

+ For offerings specific to Transition and Trade-Up, check with your Citrix sales representative or
partner for more information.

« For more information about how to start your transition from on-premises to Citrix Cloud, con-
tact your account Customer Support Manager.

Hybrid Rights

Hybrid Rights are term-based on-premises subscription licenses. These licenses are provided in ad-
dition to the cloud service subscription when an on-premises customer transitions or trades up from
an on-premises license to a cloud service subscription. Citrix rescinds your on-premises perpetual li-
censes and replaces them with a ‘like for like’ term-based on-premises licenses corresponding to the
licensing product, edition, and model of the original on-premises licenses and for the duration defined
under the applicable Cloud and/or Hybrid Rights SKUs. Hybrid Rights subscriptions provide access to
both your on-premises and Cloud resources at the same time. Only those users or devices covered by
your Citrix Cloud subscription may use the Hybrid Rights on-premises term licenses to connect to the
Citrix Cloud Services.

For example, if you have Citrix Virtual Apps and Desktops Advanced (CCU) on-premises licenses and
you trade up to Citrix Virtual Apps and Desktops Premium Service (User/Device) you get on-premises
Hybrid Rights entitlements along with the subscription licenses. Hybrid Rights are used to operate
your Citrix Virtual Apps and Desktops Advanced CCU on-premises deployment for the term of your
subscription or shorter duration as defined by the relevant SKU.

Rescinded licenses must be deleted from License Servers. For more information, see Deleting license
files. With Hybrid Rights, you can transition to Cloud gradually while running your on-premises de-
ployment in parallel, without losing out on your on-premises infrastructure.

Unless otherwise defined by the relevant SKU, Hybrid Rights are co-termed with the subscriptions pur-
chased in the corresponding Transition and Trade-Up transaction. Citrix Cloud services deployments
operate on cloud-based infrastructure. If you want to use on-premises license components (excluding
the Citrix Cloud Connector) or on-premises infrastructure to support or launch Citrix Cloud services
deployments you must purchase on-premises term licenses or Hybrid Rights separately from the rel-
evant cloud subscription. If you use on-premises deployments beyond the initial term of Transition
and Trade-Up subscriptions, additional hybrid rights add-on licenses must be purchased to continue
using those on-premises deployments.
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Hybrid Rights Add-on

You can purchase available Hybrid Right add-ons to expand your deployments, add new users, or
extend Hybrid Rights subscription terms if your migration to the Cloud is not completed.

Hybrid Right add-ons are not required for new users deployed on Citrix Cloud. However, Hybrid Rights
add-ons are required for new users if the customer wants to initially deploy the new users on on-
premises before moving them to Citrix Cloud.

If you buy Hybrid Rights add-ons for new users, you must separately buy new corresponding Cloud
subscriptions for these new users. The Hybrid Rights add-on licenses for new users cover only the
on-premises licensing.

Hybrid Rights deployment scenarios

Citrix Virtual Apps and Desktops do not support mixed editions in a single site but do support mixed
products. For more information, see Multi-type licensing.

Example for CCU licenses

« If a customer has 500 Citrix Virtual Apps Premium on-premises (CCU) licenses and transitions to
Citrix Virtual Apps Premium Service, the customer would get 500 Virtual Apps (CCU) term-based
on-premises licenses along with their corresponding Cloud subscriptions.

« However, if the customer has Citrix Virtual Apps and Desktops Advanced on-premises perpet-
ual (CCU) licenses and trades-up to Citrix Virtual Apps and Desktops Premium Service, the cor-
responding term-based on-premises Hybrid Rights licenses would be for Citrix Virtual Apps and
Desktops Advanced on-premises perpetual (CCU) licenses and not Citrix Virtual Apps and Desk-
tops Premium service. In other words, the Hybrid Right licenses the customer gets are “like for
like” under the original license product, model, and edition and not the product, model, and
edition of the newly licensed service.

Example for U/D licenses

« In the first exmaple for CCU licenses, if a customer purchases additional 500 Citrix Virtual Apps
Premium Service as an add-on, they must purchase 500 Citrix Virtual Apps Premium (U/D) Hy-
brid Right add-on licenses if their Cloud migration has not been completed at such time. They
would receive 500 Citrix Virtual Apps Premium (U/D) term-based on-premises licenses for a rel-

evant term.
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System requirements for Citrix Licensing

August 10, 2021

Requirements for Licensing

Citrix Licensing is compatible with the same hardware required to support the compatible operating
systems. Extra hardware is not required.

Notes:

+ We do not support running third party vendor daemons on the Citrix License Server, or the
Citrix vendor daemon on third party license servers.

+ The License Server does not support multi-homing (two network cards plugged into dis-
tinct networks).

+ TheCitrix Licensing Managerinstalls licenses only on the License Server where itisinstalled.
« License Servers don’t communicate with each other.
Operating system:

You can install the License Server on servers running the following Microsoft operating systems. We
recommend that you install the latest Microsoft Service Pack and updates.

« Windows Server 2022 Family
+ Windows Server 2019 Family
« Windows Server 2016 Family
« Windows Server 2012 R2 Family

Server Core installations are not supported.
Disk space requirement:

+ 161 MB for the licensing components

+ 2 GB for user/device licensing

+ More disk space might be required based on the amount of historical data that is configured in
the Citrix Licensing Manager.

Microsoft .NET Framework minimum requirements:
+ Microsoft .NET Framework 4.7.2
Cluster platforms:

« Windows Server 2022 Family
+ Windows Server 2019 Family
+ Windows Server 2016 Family
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« Windows Server 2012 R2 Family
Browsers:

We tested the following browsers. Other browsers might work, but all functionality might not be avail-
able.

+ Microsoft Edge
+ Mozilla Firefox
+ Google Chrome
« Safari

What’s next

+ Get started, install, and configure the License Server

Get started, install, and configure the License Server

August 30, 2021
Important:

+ We do not support running third party vendor daemons on the Citrix License Server, or the
Citrix vendor daemon on third party license servers.

+ We recommend that you run the latest version of the License Server. We do not provide hot-
fixes for License Server components and don’t support older License Servers with newer
products. The latest version of the License Server often contains resolutions to issues ap-
pearing in earlier versions. When you upgrade or install new Citrix products, upgrade the
licensing components as well. New License Servers are backward compatible and support
older products and license files. However, new products often require the newest License
Server to check out licenses correctly. You can find the latest version from the Citrix Down-
loads site.

To see the new features in this release, go to What’s new.

« We don’t support installing the License Server from a UNC path (\\\\server\share). In-
stall the License Server from a local copy.

Step 1 Review your prerequisites

Ensure you review the system requirements before you install and configure your License Server.
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Step 2 License your product

Licensing your product includes the following steps:

Ensure that you have the latest License Server version.
Verify the system requirements.
Install licensing.

el

Obtain license files from My Account or if you have a license code, use the Citrix Licensing Man-

ager.

5. Install your Citrix product (or, if already installed, restart the Citrix products for the new licenses
to be recognized).

6. Configure product-side licensing communication settings that were not set during the product

installation, if applicable. This configuration includes setting the correct product-edition in the

product. For more information, see Licensing elements and Services.

Ensure that the product-side edition setting correctly matches the licenses you have purchased. For
example, if you purchased Premium edition licenses, ensure that the edition setting in the product
indicates Premium and not Advanced.

For an overview of the licensing components and process, see Technical overview and Licensing ele-
ments.

Important:

The License Server does not require domain membership. You can install the License Server in
a workgroup and still perform all licensing functions on behalf of Citrix products. To manage
Citrix Licensing Manager users having Active Directory users or groups, the users must be part of

a domain. Otherwise, use local Windows users and groups.

Step 3 Check your security and firewall
Security considerations

We recommend that you upgrade the License Server to the latest version when you upgrade or install
new Citrix products. The new License Servers are backward compatible and support older products
and license files. Each time a new License Server is released, it might contain better security features
than in previous versions. We also recommend the following security considerations when you con-
figure your environment.

+ Configure the License Server environment so that only authorized administrators on a trusted
network can access the Citrix Licensing Manager port. You achieve this outcome by using an
appropriately configured network or host-based firewall.

+ When using the Citrix Licensing Manager, avoid visiting untrusted websites or clicking untrusted
URLs.
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Important:

Citrix License Server uses Microsoft Active Directory for authentication. Citrix strongly recom-
mends that you implement good security practices in Microsoft Active Directory (like account
lockout and password management) to securely deploy Citrix License Server. For more infor-
mation, see the Account lockout threshold and Password must meet complexity requirements
articles.

Firewall considerations

Determine if you require a firewall between the License Server and any product servers before in-
stalling licensing. Firewall considerations can impact where you install the License Server.

If you have hardware firewalls in your environment, you must create the necessary rules manually.

If there is a firewall between your product and the License Server, configure port numbers. This con-
figuration process entails:

+ Determining which port numbers to change. You can change port numbers during the instal-
lation process or afterward.

+ Opening up the firewall ports. Open any ports on the firewall that you changed so that traffic
can flow. Current releases configure the built-in firewall automatically.

+ Changing the product-side settings. Configure your Citrix product to use the same port num-
bers as in the Citrix Licensing Manager. If you do not change the port number referenced in
the product, the product cannot contact the License Server. You can change the product-side
settings during and after installation of the product. See your product documentation for infor-
mation about these settings.

For more information about allowing registered URLs and ports through the firewall and a list of open
URLs, see Register and remove registration with Citrix Cloud.

Step 4 Install licensing components, server, and certificate
Note:

During installation, localized characters in the installation path can cause the installation to fail.
Accept the default installation path or type only ASCII alphabetic letter characters for the instal-
lation directory.

You can install licensing components on a separate, dedicated server or on a server they share with
another application. Alternatively, you can use a web or application server. However, the locations
mentioned later in this article are less resource intensive. If you are running fewer than 50 servers or
10,000 licenses, you can install the License Server on the same server as your product. To determine
if relocation of the License Server to another system is necessary, monitor CPU and memory load
(Umgrd.exe and CITRIX.exe).
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Important:

Use the CitrixLicensing.exe file for all future installations, except for Active Directory de-
ployments. In that case, use the .msi. Ensure that both .exe and .ms1 files are present for the
installation.

Install the License Server and console using the graphical interface

1. Download the License Server from Citrix downloads and start the License Server installer,
CitrixLicensing.exe, asan administrator or a member of the administrators group.

2. Follow the installer on the GUI to accept the destination folder.

Licensing components are installed in C:\Program Files\Citrix\Licensingon a 32-bit
computerand C:\Program Files (x86)\Citrix\Licensingon a64-bitcomputer.

3. On the Configure page, accept, or change the default port numbers used by licensing compo-
nents. Choose whether to allow the installer to configure the Windows Firewall exception. If
needed, you can change the port numbers after the installation. If you choose to finish the in-
stallation without configuring the License Server, restart the CitrixLicensing.exe installer.
You can also use the License Server Configuration tool to configure the settings after the instal-
lation.

Open the configuration tool from: C:\Program Files\Citrix\Licensing\LS\resource
\Licensing.Configuration.Tool.exe.

« License server port number is 27000

« Vendor daemon port number is 7279

+ Web Services for Licensing port number is 8083

4. The License Server adds the default administrator for the Citrix Licensing Manager based on
how you are logged on. If you are in a domain, the License Server adds the installing user (do-
main\user) as a default License Server or a Citrix Licensing Manager administrator. If you are a
local Windows user, the License Server adds the installing user (computer\user) as a default ad-
ministrator account. The BUILTIN\administrator group, which allows any administrator to man-
age licensing, is added by default. You can remove BUILTIN\administrators to restrict licensing
to specified users.

5. Choose to start the Citrix Licensing Manager and whether to join the Citrix Customer Experience
Improvement Program.

Install licensing using the Windows command line

Important:

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP)
and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.
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When using the CitrixLicensing.exe command to install licensing, set properties by adding
Property=value on the command line anywhere except between an option and its argument.

Ensure that you run the command line with administrator privileges. To start the command prompt
with elevated privileges, choose Start, right-click Command Prompt, and choose Run as adminis-
trator.

The following sample command line installs licensing in silent mode. Add the properties you want to
set.

Type the command in one line without returns. The following example is in multiple lines because of
space limitations.

CitrixLicensing.exe /quiet /1 install.log INSTALLDIR=1installdirectory
WSLPORT=port_number LSPORT=port_number VDPORT=*port_number CEIPOPTIN=value

Where:
+ /quiet specifies a silent (quiet) installation.
+ [Uspecifies the log file location

« INSTALLDIR is the location where the License Server executable is stored. Optional parame-
ter. The defaultis c:\program files\citrix\licensingorc:\program files (x86)

\citrix\licensing.

« WSLPORT is the port number used for the Web Services for Licensing. Optional parameter. The
default is 8083.

« LSPORT is the port number used for the License Server. Optional parameter. The default is
27000.

« VDPORT is the port number used for the vendor daemon. Optional parameter. The default is
7279.

+ CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is ANON.

- DIAG - Call Home
- ANON - CEIP
- NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to install licensing for an Active Directory deployment

When using the msiexec command to install licensing, set properties by adding Property="value” on
the command line anywhere except between an option and its argument. Clustering is not supported
in the .msi.
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Note:

Ensure that you run the command line with administrator privileges. To start the command
prompt with elevated privileges, choose Start, right-click Command Prompt, and choose Run
as administrator.

The following sample command line installs licensing in silent mode and creates a log file to capture
any information about this operation. Add the properties you want to set after the switches.

Type the command in one line without returns. The following example is in multiple lines because of
space limitations.

msiexec /I ctx_licensing.msi /1lxv install.log /qn INSTALLDIR=1installdirectory
LICSERVERPORT=port_number VENDORDAEMONPORT=port_number MNGMTCONSOLEWEBPORT
=port_number WEBSERVICESLICENSINGPORT=port_number CEIPOPTIN=value

Where:
+ /l*visthe location of the setup log. Optional parameter.
« /qn specifies a silent (quiet) installation.

« INSTALLDIR is the location where the License Server executable is stored. Optional parame-
ter. The defaultis c:\program files\citrix\licensingorc:\program files (x86)

\citrix\licensing.

« LICSERVERPORT is the port number used for the License Server. Optional parameter. The de-
fault is 27000.

« VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter.
The default is 7279.

« WEBSERVICESLICENSINGPORT is the port number used for the Citrix Licensing Manager. Op-
tional parameter. The default is 8083.

« CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is ANON.

- DIAG - Call Home
- ANON - CEIP
- NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to disable or enable the License Management Service

The License Management Service operates automatically within the License Server and allows for li-
cense management and support. We recommend using the License Management Service for manage-
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ment of your license environment, but you can disable it anytime after installation. For more informa-
tion, see Citrix License Management Service in Technical overview.

Syntax:
ctx_license_management_service.exe (-enable | -disable | -query)
Where:

+ -enable enables license management. The first upload to Citrix occurs seven days after you
install the License Server.

+ -disable disables license management. We recommend that you use the License Management
Service to manage your licensing environment.

«+ -query displays the current configuration.

Manually install a certificate used by the Citrix Licensing Manager and Web Services
for Licensing
Note:

Use this procedure if you don’t want to use the self-signed certificate that is generated during
installation.

To install a certificate, there are three steps:

1. Obtain a.pfxfile, which contains the certificate and private key. You can use one of two methods
to obtain the .pfx file.

2. Extract the certificate and private key from the .pfx file.

3. Install the certificate and private key on to the License Server.

How to obtain the .pfx file using a domain certificate - Method 1

Log on to a server in the domain, open the MMC, and follow these steps:

1. Create a directory c:\ls_cert to hold the exported .pfx file.

2. Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Computer
account > Local computer.

3. In the left pane under Certificates, right-click Personal and choose All Tasks > Request New
Certificate, and then Next.

4. Inthe Certificate Enrollment Policy wizard, choose Active Directory Enrollment Policy, and
then Next. Select the check box next to Computer, and select Details to the right.

5. Select Properties and on the General tab, type a friendly name and description.

6. On the Subject tab, under Subject Type, choose Common name from the Type menu. Type a
friendly name in the text box, choose Add, and then Apply.
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1.

10.

11.

12,

13.

On the Extensions tab, choose Key usage from the menu. Add Digital signature and Key en-
cipherment to the Selected options box.

On the Extended Key Usage menu, add Server Authentication and Client Authentication to
the Selected options box.

Onthe Private Key tab and under the Key options menu, ensure that the Key size is 4096. Select
the Key Exportable check box, and then Apply.

On the Certification Authority tab, ensure that the CA check box is selected, and then OK >
Enroll > Finish.

In the Certificates console, select Personal > Certificates, choose the certificate you built. Se-
lect All Tasks > Export > Next, and select the Yes, Export the Private Key radio button, and
then Next.

Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all
certificates, choose Next, create a password, and choose Next.

Click Browse, navigate to C:\1s_cert and type server.PFX, and then follow the wizard to
finish.

How to obtain the .pfx file sending a request to a certificate authority (CA) - Method 2

These steps might vary based on your Certificate Authority.

1.

Log on to the License Server, open the MMC, and follow these steps:

a) Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Com-
puter account > Local computer.

b) In the left pane under Certificates, right-click Personal and choose All Tasks > Advance
Operations > Create Custom Request, and then Next.

c) Inthe Certificate Enrollment Policy wizard, choose Proceed without enrollment policy
under Custom Request, and then Next.

d) On the Custom request screen, choose (No template) CNG key from the menu and
PKCS#10 for the Request format, and then Next.

e) On the Certificate Information screen, choose Details and then Properties.

f) On the General tab, type a friendly name and description.

g) On the Subject tab, under Subject name, choose Common name, and type a value in the
text box.

h) On the Extensions tab, choose Key usage from the menu, add Digital signature and Key
encipherment.

i) Onthe Extensions tab, choose Extended Key usage from the menu, add Server Authen-
tication and Client Authentication.

j) On the Private Key tab, under Cryptographic Service Provider, choose RSA, Microsoft
Software Key Storage Provider (the default). From the Key options menu, ensure that
the key size is 4096, select the Key Exportable check box, and then Apply.
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k) Save the file to a .reqfile, submit the .req file to a Certificate Authority (CA), and save the
.cer file.

In the MMC, under Certificates, right-click Personal and choose All Tasks > Import. In the Im-
port wizard, select the .cer file.

Create a directory c:\ls_cert to hold the exported .pfx file.

In the Certificates console, choose Personal > Certificates, and choose the certificate you im-
ported. Select All Tasks > Export > Next, and select the Yes, Export the Private Key radio
button and Next.

Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all
certificates, choose Next, create a password, and then choose Next.

Choose Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to fin-
ish.

How to extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key
from a .pfx file. The version of OpenSSL shipped with the License Server does not support extracting
certificates and private keys. For information about downloading OpenSSL, go to www.openssl.org.

Citrix recommends installing OpenSSL on a separate workstation to perform these steps:

1.

2.

Navigate to the <openssl directory>\bin folder.
Runopenssl pkcsl2 -in C:\ls_cert\server.pfx -out server.crt -nokeys
Note:

The License Server uses only the .crt certificate format.

Type the password created during the export process (password).

Run openssl pkcsl2 -in C:\ls_cert\server.pfx -out server.key -nocerts -

nodes

Type the password created during the export process (password).

How to install the . crt and . key files on the License Server

Windows - Web Services for Licensing:

1. Stop the Citrix Web Services for Licensing service.

Copy the server.crt and server.key created earlier in this procedure to c: \program files (
x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\.

Start the Citrix Web Services for Licensing service.
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Windows - License Administration Console:
Note:

 License Administration Console was removed from Windows License Server v11.16.6.0
build 31000 and onwards. For more information, see What’s new.
+ License Server VPX still uses the License Administration Console.

1. Stop the Citrix licensing service.
2. Copy the server.crt and server.key created earlier in this procedure to c:\Program Files (

x86)\Citrix\Licensing\LS\conf.
3. Start the Citrix licensing service.

Step 5 Configure a proxy server

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you configure
a proxy server, requests to download licenses and upload Call Home data are sent through a proxy

server.

Important:

Citrix Licensing components requiring outward bound web communications can inherit network
proxy settings using Windows automatic proxy detection. We do not support authenticated prox-
ies. For more information about Windows automatic proxy detection, see WinHTTP AutoProxy

Functions.

How to configure a proxy server manually

1. Edit the SimpleLicenseServiceConfig.xml file, which is in the <Citrix Licensing>\

WebServicesForLicensingdirectory.
2. Add a line of xml to the file in the format <Proxy>proxy server name:port number</

Proxy>

Important:

The .xml tags are case-sensitive.

<Configurations>
<EncoreConfiguration>
<SamplingPeriod>15</SamplingPeriod>
<RetentionTime>180</RetentionTime>
<Enabled>true</Enabled>
</EncoreConfiguration>
<Proxy>10.211.55.5:808</Proxy>
</Configurations>
<!--NeedCopy-->
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Next steps

« Citrix Licensing Manager
+ Product specific licensing guides

Prerequisites to obtain your license files

May 11, 2021
After you install the licensing components, you are ready to obtain your license files.
You can obtain your license files in several ways:

« Studio in Citrix Virtual Apps and Desktops. For more information, see Citrix Virtual Apps and
Desktops Licensing.

« Citrix Licensing Manager.

+ MyAccount on citrix.com. For more information, see Manage Licenses on citrix.com.

Ensure you have the following information ready, before going to the Citrix website to get your product
licenses:

« Your user ID and password for My Account.

+ The license access code. You can get this code in My Account on citrix.com or in an email you
receive from Citrix.

Note: If you cannot locate the license access code or licenses you purchased, contact the Citrix
Customer Service.

« The hostname of the License Server on which you installed the licensing components. The
License Server hostname is case-sensitive, so ensure that you copy the name exactly as it ap-
pears on the system.

Select the down arrow in the top bar of the Citrix Licensing Manager screen to find the License
Server hostname, Ethernet address, and IPv4 address. You can also run the hostname com-
mand at a command prompt on the License Server.

+ How many licenses you want to include in the license file. You do not have to download all
the licenses you are entitled to at once. For example, if your company purchases 100 licenses,
you can allocate and download only 50 now. Later, you can allocate the rest in another license
file. You can have more than one license file based on the number of licenses allocated.
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Customer Success Services

May 27,2021

Your purchase of a new Citrix product includes a one-year membership in Customer Success Services.
This membership entitles you to all product updates, along with other benefits. These updates in-
clude all releases during your membership period.

After your initial one-year membership period expires, renew your Customer Success Services mem-
bership by paying Citrix for your renewal. Use the Citrix Licensing Manager to install your renewal
licenses. You can go to citrix.com and download a license file that has your renewal license.

Important:

A Customer Success Services membership and its license are distinct from your license to run
the product. Your Citrix products don’t stop working if you don’t renew your Customer Success
Services membership. But you are not entitled to any software releases after it expires.

Customer Success Services renewal licenses

Customer Success Services renewal license files contain licenses, known as renewal licenses, that ex-
tend your Customer Success Services membership for a one-year period. These licenses are required
torun all new product releases, excluding hotfixes, that are released during your membership period.

If you do not add the Customer Success Services renewal licenses immediately, your Citrix products
do not stop working. However, you cannot run any new software released during your renewed mem-
bership until you have the renewal license on your License Server.

If Citrix releases a product version after your Customer Success Service membership ends, renew your
Customer Success Services membership. Obtain a renewal license before you can use the new product

version.
Example:

Before you upgrade to any of the Citrix Virtual Apps and Desktops releases, ensure that your current
Customer Success Services dates are valid and have not expired. Citrix Virtual Apps and Desktops
releases use a year-month date format (YYMM). Ensure that the date in your license is equal or newer
than the product release date. For a comprehensive list of release dates, see Citrix Product Customer
Success Services Eligibility Dates.

When you renew your Customer Success Services membership, you can use the renewal license fea-
tures of the Citrix Licensing Manager. For more information see, Update licenses.
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Note:

When you download more license files, you can delete the expired Customer Success Services
licenses. However, it is not a requirement. You might want to keep them to make it easier to
identify the upgrade that is associated with each base license.

Find out your Customer Success Services dates by using Citrix Licensing Manager, or view the license
file in the text editor.

Check for and install Customer Success Services renewal licenses with the Citrix
Licensing Manager

When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for avail-
able Customer Success Services renewal licenses.

Based on your configuration, the Citrix Licensing Manager automatically checks for Customer Success
Services renewal licenses, or allows you to check manually. It notifies you orinstalls the licenses when
found.

1. In the Citrix Licensing Manager, click Settings in the upper right of the UI.
2. Choose how you want to be notified and if you want renewal licenses to be automatically in-
stalled.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall set-
ting or configure a proxy. For this feature to work, the License Server must be able to access https:
//citrixservices.citrix.com. For more information, see Configure a proxy server manually in the Get
started article.

Note:

You can also configure the ports, the supplemental grace period, and the language on this page.

« Automatically check for Customer Success Services renewal licenses and notify when
available: Citrix Licensing Manager displays a notification. Click the link to download and
install the available renewals. This same notification appears in Studio and Director if they are
configured to manage the License Server.

« Automatically check for and install Customer Success Services renewal licenses when
available: Citrix Licensing Manager checks weekly and automatically installs renewal licenses
when available. A notification displays for a few days stating that renewals have been installed.

« Manually check for Customer Success Services renewal licenses: Select the Update
Licenses tab and Check for Available Renewals. You can check the Update Licenses tab at
any time to see a list of licenses installed in the last 30 days.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 66


https://docs.citrix.com/en-us/licensing/current-release/citrix-licensing-manager.html
https://citrixservices.citrix.com
https://citrixservices.citrix.com
https://docs.citrix.com/en-us/licensing/current-release/getting-started.html
https://docs.citrix.com/en-us/licensing/current-release/getting-started.html

Licensing 11.17.2 build 36000

Citrix Licensing Manager

September 9, 2021

The Citrix Licensing Manager is a web based management console for Citrix Licensing. It enables the
License Server features using a simple web interface. For more information on the functions you can
perform using the Citrix Licensing Manager, see Citrix licensing technical overview.

The Citrix Licensing Manager is installed on the license server. You can only use it to manage the
license server on which itisinstalled. The Citrix Web Services provide the functionality for the Licens-
ing windows service.

Access the Citrix Licensing Manager using the link https: //*LicenseServerName :WSLPortx*. The
default WSL Port is 8083.

License Server Version

Citrix Licensing Manager M17.2.0 build 36000 ~

Dashboard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL IN USE/INSTALLED AVAILABLE
Citrix Start-up License Server 0/10000 10000(100%) >
Citrix License Server Diagnostics License Server 0/10000 10000(100%) >

The Citrix Licensing Manager screen displays the following details:

» The License Server version in the top bar of the screen. You can also view the host name, Ether-
net address, and IPv4 address, from the drop-down list in the titlebar.
by selecting the down arrow at the top right of the Citrix Licensing Manager screen.

« Important notifications of license availability, expiration, and other conditions. You can view
these notifications by selecting the bell icon at the top of the Citrix Licensing Manager screen.

The Citrix Licensing Manager also allows you to perform the following actions:

+ Configure Customer Success Services renewal license actions. Specify whether to download
and install licenses automatically, check for the available renewals and notify, or manually in-
stall the licenses. For more information on configuring this feature, see Check for and install
Customer Success Services renewal licenses with the Citrix Licensing Manager.

« Store and export historical usage reports from the License Server. You can specify a date range
for the historical usage data and export it to a CSVfile. The CSV file provides daily usage informa-
tion including the number of licenses in overdraft. For information about exporting historical
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usage data, see Historical Use.

Prerequisites

See the System requirements for Citrix Licensing article to understand the prerequisites and require-

ments.

Where to go next

Dashboard: View details about the installed, in-use, available licenses, expiration date of li-
censes, and Customer Success Services dates.
For more information, see Dashboard.

Historical use: Review and export data related to products, license models, and Customer Suc-
cess Services (Subscription Advantage) dates.
For more information, see Historical Use.

Install licenses: Install license files on the License Server using a license access code or down-
loaded file. View details of licenses after they are installed.
For more information, see Install licenses.

Update licenses: Check for, download, install, and update available Customer Success Services
renewal licenses.
For more information, see Update licenses.

Settings: Modify settings related to user and group accounts, server configuration, and usage
and statistics data. For more information, see Settings.

Dashboard and Historical Use

May 28, 2021

Dashboard

The Dashboard in Citrix Licensing Manager provides information about product edition, model, in-

stalled or in-use status and availability of your licenses.
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License Server Version

Citrix Licensing Manager 11.17.2.0 build 36000

Dashhoard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL IN USE/INSTALLED AVAILABLE
Citrix Start-up License Server 0/10000 10000(100%) >
Citrix License Server Diagnostics License Server 0/10000 10000(100%) >

To view detailed information about the licenses, click > for a particular license. The Citrix Licensing
Manager displays a table containing the following details of the license:

« Customer Success Services date
« Total installed licenses

+ Overdraft

« Licensesin use

« Available licenses

+ Expiration date

« Type
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License Server Version
11.17.2.0 build 36000

Citrix Licensing Manager

Dashboard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL IN USE/INSTALLED AVAILABLE
Citrix Start-up License Server 0/10000 10000(100%;) ~
Licenses
CSS Date Total Installed Overdraft In use Available Expiration Date Type
20380101 10000 0 0 10000 PERMANENT System
Citrix License Server Diagnostics License Server 0/10000 10000(100%;) >
Note:

The dashboard data updates every five minutes.

Historical Use

The Historical Use feature in the Citrix Licensing Manager allows you to store and export historical
usage reports from the Licensing Server. The default retention period is one year. You can view and
specify the data retention period by selecting Change. Use the filters to export a License Server Prod-
uct usage report as a CSV file.
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License Server Version

Citrix Licensing Manager 11.17.2.0 build 36000~

Dashboard Historical Use Install Licenses Update Licenses

Historical Use

Use these filters to export a License Server Product usage report for the specified time period as a .csv file.

Product & Edition Madel
Citrix Start-up License (CITRIX) i Server g
Customer Success Services Date Start Date End Date
2038.0101 ~ 08/23/202"[#] 08/23/2021[:&

Historical data is retained 1Year Change

Export historical usage data

You can view and export the historical usage by performing the following steps:

1. LogontotheCitrix Licensing Manager hosted on the License Server. Type the following URL into
a browser on a system having access to the License Server, and use your actual License Server

host name.
http://License-Server-Hostname:8083/

2. Select Product & Edition, Model, and Customer Success Service Date. Enter a date range for
which you want to gather the history.

Note:
Selecting Customer Success Services date limits exported data to a specific pool of licenses
and does not accurately reflect the total number of licenses in use.

3. Select Export.

4. Select Save > Save As on the browser download dialog to save the exported CSV file. The CSV
file provides daily usage information, including the number of licenses in overdraft.
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Install licenses

May 28,2021
The Citrix Licensing Manager gives you the following options to obtain your licenses:

« Use license access code
« Use downloaded license file

Inthe Start menu, select AllPrograms > Citrix > Citrix Licensing Manager, or from a remote machine
usethe https://licenseservername:8083 URL with your License Server name.

— . - License Server Version
Citrix Licensing Manager 11720 build 36000 A I} Hel

Dashboard Historical Use Install Licenses Update Licenses

Install Licenses

Choose the method to install licenses on the License Server.

License Server Information
Hostname: IP Address:
You can choose to install licenses by using the license access code or a license file (.lic).

@ Use license access code O Use downloaded license file

License Access Code

Use license access code

1. Choose Use license access code, and enter the license access code provided by Citrix.
2. Click Display Licenses to see your license entitlements.
Select the licenses and the quantity to install.

3. Selecta product from the displayed list, type the number of licenses to install, and click Install.
To select multiple products, click Install every time you select a product. The products are pro-
cessed in order of selection.

4. To display the newly downloaded licenses, click Dashboard.
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@ Use license access code

License Access Code

Display Licenses

O Use downloaded license file

License Entitlements

Quantity/Available Already Used

Product Name

Citrix Access Gateway and Advanced Access Control -

With Subscription Advantage

Product-Type

CSS Date

pCitrix Access Gateway - Advanced Edition|Concurrent-Retail

pCitrix Access Gateway - Standard Edition|Concurrent-Retail

Use downloaded license file

O Use license access code

License File

Choose File

3/ a9

Available

@® Use downloaded license file

Action/Progress

/" Installed

Expiry Date

Installed License Details

Product-Type

CSS Date

wCitrix XenDesktop WDI|Concurrent (Legacy)-Retail

20221201
20221202
20221203
20221204
20221205
20221206
20221207
20221208
20221209
20221210

1. Choose Use downloaded license file.

Available

100
100
100
100
100
100
100
100
100
100

Expiry Date

01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
01-dec-2022
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2. Choose afile.
3. Choose the check box to replace an older file with the same name.
4. Click Import.
The Citrix Licensing Manager displays information about the licenses.

5. After your license file is successfully uploaded to the License Server, a message displays. To
display the newly downloaded licenses, click Dashboard.

Note:

Avoid issues while uploading a license file by removing special characters in the file name.

Ensure that the file has a .lic extension (all lower case).

Allocating and downloading licenses

Consider the following points while using the Citrix Licensing Manager to allocate and download li-

censes:

+ As a prerequisite, ensure that you have internet access or a configuration with a proxy server.

« Once you click Allocate > Download, you cannot cancel it. If this action fails, use My Account
at citrix.com.

+ The Citrix Licensing Manager doesn’t support redownloading or reallocating of license files. You
can return licenses on citrix.com and use the Citrix Licensing Manager to allocate them again.
For redownloading, use My Account.

« If you rename the License Server, you must reallocate any license files allocated under the old
License Server name.

Update licenses

June 9,2021

Install your Customer Success Services renewal licenses from the Update Licenses tab in the Citrix Li-
censing Manager. You can also see a record of the recently installed renewal licenses in the Customer
Success Services renewal licenses renewed in the last 30 days section.

To update the licenses

1. In the Customer Success Services renewal licenses available section, click Check for Avail-

able Renewals.
2. Click Download and Install to install the licenses. For more information see Use downloaded
license file section in Install licenses.
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“m_C A a Li S Versi
Citrix Licensing Manager e o e

11.17.2.0 build 36000

Dashboard Histarical Use Install Licenses Update Licenses

Update Licenses

License Server Information

Hostname IP Address
Customer Success Services renewal licenses available Check for Available Renewals
Product Name Quantity CSS Date Action

Citrix XenDesktop Platinum|User/Device 25 2018.1215

Customer Success Services renewal licenses installed in the last 30 days

No renewal licenses were installed

Settings

August 16, 2021

Modify and configure the following settings in the Citrix Licensing Manager:

+ Account: Configure user and group accounts.

+ Server configuration: Configure ports and Customer Success Services renewal license actions.

+ Usage and statistics: Register your License Server with Citrix Cloud and configure the historical
data retention by selecting a retention period.

To configure these settings, click the settings icon on the top right corner of the title bar.
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License Server Version

Citrix Licensing Manager 1.17.2.0 build 36000 ~

Dashhoard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL IN USE/INSTALLED AVAILABLE

Citrix Start-up License Server 0/10000 10000(100%) >

Citrix License Server Diagnostics License Server 0/10000 10000(100%) >
Account

On the Account tab, configure users and group access for both local Windows users and groups and
Active Directory users and groups.

Note:

Active Directory users and groups are part of an Active Directory or network authentication sys-
tem. To support them, ensure that the Windows License Server is a member of a Microsoft Active
Directory domain.

Administrator and User roles

You can add User and Group accounts with specific roles. User and Group accounts created with an
Administrator role can:

+ Choose a console display language.

« View system information.

+ Add and remove users.

+ Configure the License Server port.

+ Configure the vendor daemon port.

+ Configure the Web Services for Licensing port.
+ Configure and add licenses.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 76



Licensing 11.17.2 build 36000

License Server Version

Citrix Licensing Manager e T
Dashboard Historical Use Install Licenses Update Licenses
Settings

Account Server Configuration Usage and Statistics

User Administration

Configure user and group access to manage this License Server.

Group
STRATORS Administrator Group W
Individual
Administrator Individual

User and Group accounts created with a User role cannot log into Citrix Licensing Manger. These
accounts have only read-only access to Licensing through Citrix Studio.

Note:

User as an account (red color) is different from User as a role (green color) as indicated in the

above image.

To add and remove users and groups

To add a user or a group, click Add, choose User or Group, enter Domain\Username, and then click
Finish.

To remove a user or a group, click User or Group from the list and then click Remove.

To edit the role of an existing user or group, click the edit button, choose the role, and click Update.

Server configuration

Use the Server Configuration setting to make the following changes:
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« Configure the License Server, Citrix vendor daemon, and Web Services for Licensing ports.

Configure Customer Success Services renewal license actions.

Enable and disable the supplemental grace period.
+ Choose the console display language.

Settings

Account Server Configuration Usage and Statistics

Configured Ports

License Server Port @ 27000
Vendor Daemon Port @ 7279 V2
Web Services for Licensing Port @ 8083

Customer Success Services Renewals (D)
@ Automatically check for Customer Success Services renewal licenses and notify when available.
(O Automatically check for and install Customer Success Services renewal licenses when available.

(O Manually check for Customer Success Services renewal licenses.

Supplemental Grace Period

Start the 15-day supplemental grace period when the regular license consumption limit is
reached.

Language English 74
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Configure port numbers

You can edit the following default ports:

+ License Server. This port number is used by the Citrix Licensing Manager. License Server Man-
ager handles the initial communication among the products, starts the Citrix vendor daemon,
and relays check out and check in requests to the vendor daemon. By default, this port number
is 27000.

+ Citrix vendor daemon. This port number is used by the Citrix vendor daemon. The vendor
daemonisresponsible forthe core operations of the License Server, including license allocation.
By default, this port number is 7279. However, if you have a firewall or if the number is already
in use, you must change the port number.

« Web Services for Licensing. Port used by the Web Services for Licensing. The Web Services
for Licensing hosts the Citrix Licensing Manager, so users connecting to the Citrix Licensing
Manager use this port. Director and Studio use this port to communicate with the License Server
using Web Services for Licensing. By default, this port number is 8083.

Customer Success Services Renewals

Thisfeature checks foralready available renewed licenses, and notifies they are available for renewals,
or automatically installs them. When enabled, the Citrix Licensing Manager contacts Citrix.com web
services weekly to check for available Customer Success Services renewal licenses.

You have the following options to renew Customer Success Services licenses:

« Automatically check for Customer Success Services renewal licenses and notify when
available

+ Automatically check for and install Customer Success Services renewal licenses when
available

« Manually check for Customer Success Services renewal licenses

The check for available renewals is performed weekly. To manually update your licenses, click Update
License > Check for Available Renewals. Check the Update License tab at any time to see a list of
licenses installed in the last 30 days.

Based on your configuration, the Citrix Licensing Manager does one of the following:

+ Checks for Customer Success Services renewal licenses, notifies you, and installs the licenses
when found.

« Checks for Customer Success Services renewal licenses, and notifies you they are available to
be installed.

+ Allows you to check manually.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall set-
ting or configure a proxy. For this feature to work, the License Server must be able to access https:
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//citrixservices.citrix.com.

Supplemental grace period

You can use the Supplemental grace period feature to start the 15-day supplemental grace period,
when you reach the regular license consumption limit. During the supplemental grace period, the
product allows unlimited connections for 15 days, enabling you to fix the issue. Ensure you check
your product documentation to determine if your product supports the supplemental grace period.

Language

You can change the default language of the Citrix Licensing Manager display, which applies to all the
console users. The following languages are available:

« Chinese (Simplified)
+ English

 French

« German

» Japanese

+ Spanish

Support Bundle

A support bundle is a .zip file that contains information the Citrix Support team can use to trou-
bleshoot and debug license server issues. You can use this file to initiate a Citrix support call or to
provide documentation to Citrix or its agents for license compliance purposes. The .zip file generated
includes license activity and historical usage information, configuration information, a copy of the
licensing directory, license files, server logs, and usage and analytics data from Call Home, CEIP or
Citrix License Management Service or both (in each case, if applicable).

To generate and download a support bundle, go to the Citrix Licensing Manager > Settings > Server
Configuration > Support Bundle. Click Generate and Download to download the bundle (.zip file).

The support bundle contains various files. See the following table for a list of files that are of high
importance in the bundle:

File name Description
LS\conf Includes server configuration and certificates.
LS\logs Contains license server logs.
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File name

LS\resource\cache

LS\resource\Historical

LS\resource\usage

LS\MyFiles

WebServicesForLicensing

WebServicesForLicensing\Apache\conf

WebServicesForLicensing\Logs

Usage and statistics

Description

Contains user/device data, renewal database,

and vendor daemon extension data. There are
also upload result files that contain the status

of the last telemetry transfer.

Contains Web Services for Licensing/Citrix
Licensing Manager analytics and historical use
databases.

Contains files included in the last compliance
and/or CEIP/Call Home upload bundle along
with corresponding .zip files for each program.

Contains all installed customer license files
and the CITRIX.opt (options file - contains LS
configuration).

SimpleLicenseServiceConfig.xml Web

Services for Licensing Configuration file.

Contains Web Services for Licensing web
server configuration and certificates.

Contains Web Services for Licensing web
server logs.

Use the Usage and Statistics setting to do the following:

+ Configure how you share usage statistics with Citrix.

+ Find out if your License Server is registered, or register your License Server with Citrix Cloud.

+ Know the status of your uploads, and fix failed uploads.

« Force data upload to Citrix.

+ Set the period to retain the historical usage information.
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License Sarver Varsion

Citrix Licensing Manager 11.17:2.0 build 36000
Dashboard Historical Use Install Licenses Update Licenses
Settings
Account Server Configuration Usage and Statistics

Share usage statistics with Citrix

@ Allow

ct system nformation, license usage. &

user/device data from your License

Server. Providing ata and r License Server with Citrix Cloud helps you and Citrix
understand how your licenses aré usad over time
Register this License Server to enable License Usage Insights in Citrix Cloud

(O Help improve Citrix products by sending detailed License Server system and usage information (which

doas not identify users) to the Citrix Customer Experience Improvament Program (CEIP

(O Sendonly basic License Server system and usage information (which does not identify users) required

for license compliance purposes
Configure usage telemetry
Send identifiable username and device |D data
[0 Replace identifiable username and device ID data with non-identifiable values before transmission

Learn more about the License Server information collected by the License Management Service and additional

collection options and information

Register and remove registration of your Citrix License Server

Use the Register option in the Usage and Statistics section to register your Citrix License Server with
Citrix Cloud. Once registered, the screen indicates that you are registered. Use the Remove Registra-
tion option if you want to remove the License Server registration. For more information, see Register
Citrix License Server with Citrix Cloud.

Share usage statistics

The Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home usage and ana-
lytics programs are voluntary data collection programs designed to improve your product experience.
CEIP is enabled by default during License Server installation. Call Home is voluntary. You can partici-
pate in the programs anonymously, choose to be identified, or decline to participate. You can change
your participation in the program at any time by using the Citrix Licensing Manager.

For more information about the statistics that are collected, see Citrix licensing Customer Experience
Improvement Program (CEIP), Call Home, and compliance usage and analytics programs.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 82


https://docs.citrix.com/en-us/licensing/current-release/license-server/licensing-elements.html#citrix-licensing-customer-experience-improvement-program-ceip-call-home-and-compliance-usage-and-analytics-programs
https://docs.citrix.com/en-us/licensing/current-release/license-server/licensing-elements.html#citrix-licensing-customer-experience-improvement-program-ceip-call-home-and-compliance-usage-and-analytics-programs

Licensing 11.17.2 build 36000

Important:
If you’re not redirected to the Product Registration experience, do the following:

1. Gotocitrix.cloud.comand logon.
2. Select your company, and select menu > Identity and Access Management > API Access
tab > Product Registrations.

For more information, see Register on-premises products with Citrix Cloud.

Your License Server is registered successfully in Citrix Cloud. You can view the details in the Citrix
Cloud UL.

Remove registration

There are reasons that you might want to remove the License Server registration with the Citrix Cloud.
For example, you’ve registered your License Server to CompanyA, which is now merged into another
organization. You want to consolidate your license usage data into one Citrix customer account. To
do that, remove your registration, and then register with a new Citrix Cloud account.

Configure usage telemetry

By using this feature, you have the option of allowing Citrix to collect data from the License Server.
You can choose to send data in an unidentifiable format, or choose not to send data. You have the
following options:

 Selectthe Send identifiable user name and device ID data option to send your user name and
device ID.

« Select Replace identifiable user name and device ID data with non-identifiable values be-
fore transmission options to send your user name and device ID in a non-identifiable format,
once you have selected the Send identifiable user name and device ID data.

+ Donotselect the Send identifiable user name and device ID data option if you don’t want you
send your user name and device ID.
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Settings

Account Server Configuration Usage and Statistics

Share usage statistics with Citrix

@ Allow Citrix to collect system information, license usage, and user/device data from your License
Server. Providing this data and registering your License Server with Citrix Cloud helps you and Citrix
understand how your licenses are used over time.

Register this License Server to enable License Usage Insights in Citrix Cloud.

O Help improve Citrix products by sending detailed License Server system and usage information (which
does not identify users) to the Citrix Customer Experience Improvement Program (CEIP).

(O Send only basic License Server system and usage information (which does not identify users) required
for license compliance purposes.

Configure usage telemetry
Send identifiable username and device |1D data.

Replace identifiable username and device ID data with non-identifiable values before transmission.

Learn more about the License Server information collected by the License Management Service and additional
collection options and information.

Upload Information

Upload information

Provides status for the last Citrix Customer Experience Improvement Program (CEIP), Call Home, or Citrix Service
Provider Program upload.

Last successful upload Not available

Upload now

This Upload information feature provides the status for the last CEIP, Call Home, or Citrix Service
Provider upload. You can force a data upload to Citrix without waiting for the daily upload. Click
Upload now to force a data upload to Citrix, when CEIP is enabled. For successful uploads, allow five
minutes between uploads.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 84



Licensing 11.17.2 build 36000

If the upload fails, the Citrix Licensing Manager displays the troubleshooting information.

Historical Use

Use the Historical Use feature to choose the retention period to retain your License Server usage
information. The default historical use retention period is one year.

Historical Use

Retention Period @ 1Year 74

Register and remove registration of your Citrix License Server

May 28, 2021

Register your Citrix License Server

Register your Citrix License Server with Citrix Cloud, by using a short-code activation process, using
the Register option in the Usage and Statistics section of the Settings.

Once registered, the screen indicates that you are registered, and you can use the Remove Registra-
tion option to remove the License Server registration.

By registering the License Server with Citrix Cloud, you allow the License Server to collect and store
the Call Home license usage information, and regularly transmits that data to Citrix Cloud.

For steps to register an on-premise License Server, see Register on-premise products with Citrix Cloud.

View the status of your Citrix License Servers to understand which ones are successfully reporting
usage and when they last reported usage to Citrix Cloud. For more information, see Monitor licenses
and usage for on-premises deployments.

After your License Server is registered successfully in Citrix Cloud, you can view the details in the Citrix
Cloud UL.

Important:

Before registering your License Server with Citrix Cloud, use the firewall rules to open the follow-
ing URLs:
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https://trust.citrixnetworkapi.net:443
https://trust.citrixworkspacesapi.net:443
https://cis.citrix.com port 443
https://core.citrixworkspacesapi.net:443
https://core-eastus-release-a.citrixworkspacesapi.net
https://core.citrixworkspacesapi.net
ocsp.digicert.com port 80
crl3.digicert.com port 80
crl4.digicert.com port 80
ocsp.entrust.net port 80

crl.entrust.net port 80

crl.entrust.net port 80

Ensure that the License Server can access the Certificate Revocation List server for DigiCert and
Entrust. The License Server checks the server to see if the required certificates are valid or re-
voked.

Steps to register your License Server
To register your License Server by performing the following steps:
1. Navigate to Settings > Usage and Statistics.

2. Click Register to generate an 8-character alphanumeric code.
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Use this code to register this License Server with Citrix
Cloud

wView details

Z I /AL-WA F 6 [on]

The code expires in 4 minutes 32 seconds

3. Select View details to view your License Server version, MAC ID, host name, and IP address.
4. Click Register. You’re navigated to the Citrix Cloud sign-in page.

5. Enter your Citrix Cloud account credentials and navigate to Product Registration > Register.
Enter the 8-character alphanumeric code, and click Continue.

6. Review the registration details and click Register.
Note:
If you’re not redirected to the Product Registration experience, do the following:

1. Go to citrix.cloud.com and sign in to Citrix Cloud.
2. Selectyourcompany, select Identity and Access Management >API Access tab > Product
Registrations from the select menu.

Remove registration of your License Server

If you want to register your license server with a different or new Citrix Cloud account, remove the
registration and re-register the license server.
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To remove your license server registration navigate to Settings > Usage and Statistics, and click Re-
move Registration. Review and confirm the confirmation message.

Remove registration with Citrix Cloud

Remaoving registration of this License Server will delete registration information and disable usage
collection and transmission.

.

The registration of your License Server is removed from Citrix Cloud. You can now follow the steps to
register your license server and register with a new Citrix Cloud account.

Manage Licenses on citrix.com

July 13,2021

This article describes how to manage licenses at citrix.com. You can choose Manage Licenses to easily
find, allocate, download, modify, return, hide, and unhide licenses.

Note:

You can perform several licensing actions from Citrix Studio and Citrix Licensing Manager also.
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To access Manage Licenses on citrix.com

1. From a web browser, go to http://www.citrix.com.
2. Select Sign In > My Account and type your user ID and password.
3. Select Manage Licenses.

CITRIX Presdicts Downloads Support & Serdoes Partners E - =

Manage Licenses

ijl |5]

|
L

Find a licensa h:,*_.

Shaw achvancnd iearch opticnd

RO % [

LEcense acoess (ode = Alogbed

& .

0

Search for licenses

Inthe Find a license by... menu, choose the search criterion, type the search text, and select Search.
You can select Show advanced search options to narrow down your search further.

Allocate licenses

1. Select the licenses you want to allocate. The landing page displays only new licenses within 30
days and expiring term licenses. You can use the Find a license by... search to find all licenses
using one of the search criteria and then the Filter by menu to narrow the display down to
specific types of licenses or you can select Quick find: All active to see all licenses.

2. From the Select an action menu, choose Allocate licenses.

3. Enter the Binding ID (for example: Host name or Ethernet address) and how many licenses to
allocate, and click Create license file.

4. Select Yes, create license file. If you want to make a change before creating the license file,
select No, modify the allocation, and make your change. Then select Yes, create license file.

5. Select Download license file, and save the file to a temporary location. Remember the file
name and location where you downloaded the file. You need this location.
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6.

Install the license. See Install licenses.

Download licenses

1.

Selectthelicenses you wantto download. Thelanding page displays only new licenses within 30
days and expiring term licenses. You can use the Find a license by... search to find all licenses
using one of the search criteria and then the Filter by menu to narrow the display down to
specific types of licenses or you can select Quick find: All active to see all licenses.

From the Select an action menu, choose Download all licenses and save thefile to atemporary
location (mostly the downloads folder).

Copy the downloaded license files to the MyF1iles folder:

e C:\Program Files\Citrix\Licensing\MyFiles on a32-bitcomputer
o C:\Program Files (x86)\Citrix\Licensing\MyFiles on a64-bitcomputer

Ensure that the license file retains the lower case .lic file name extension. Some copy processes
don’trecognize afile type for that extension and add a “.txt” file name extension during the copy.
You can’timport license files that have the wrong file name extension.

At a command prompt, navigatetothe C: \Program Files (x86)\Citrix\Licensing\LS
or C:\Program Files\Citrix\Licensing\LS folderand type the following command:

Imreread -c @localhost -all

For more information aboutthe lmreread command, see Reread license and optionsfiles (Imreread).

Installing licenses

For information about installing licenses for specific solutions from Citrix, see the following:

Licensing guide for Citrix Virtual Apps and Desktops
Licensing guide for Citrix ADC

Licensing guide for Citrix Gateway

Licensing guide for Citrix Hypervisor

Licensing guide for XenMobile Server

Licensing guide for Citrix Provisioning

Licensing guide for Citrix SD-WAN

For information about installing licenses using the Citrix Licensing Manager, see Install licenses.

Display asset components

To display asset components, click View my products at the top of the page. Choose a license and

click the down arrow to expand and view the details. You can toggle between the order number and
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the license access code view.

Find a license by... Clear search

Licensessenal number

Purchase date FCH Active only

Hide advanced search options

Export list [CSV) & 5 s 12/2272018 To 12/22/2018

Product name Cirder Number r Quantity

= Virtual Desktops Service 5880
Purchased: 12/22/2018 Bxpiring: 12/22/2021

@ | Endpoint Management Service 2500
Purchased 13/23/2018 Expiring: 12/32/3021

Mame License access code ¥ Quantity
Endpoint Management Service 2500
Workspace Environment Management 2500
Citrix VPX 3000 MBFS License FJ
Citrix Connector VPX 200Mbps 2
@ (Vitual Desktops Service 4200

Purchaced 127233018 Expiring: 12/32/30F1

@ |Mirtual Desktops Service 300
Purchased: 12/22/3013 Expiring: 12/22/230x1

Return allocations

Returning allocations puts the licenses back in the licensing pool. You can then allocate these licenses
in any quantity at any time. For example, you’re decommissioning a License Server, but you’re not
ready to deploy existing licenses elsewhere.

1. Select the check box of the licenses you want to return.
2. From the Select an action menu, choose Return allocations.
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3. Select Yes, process return. If you choose this option, you cannot undo it.

Modify licenses

Modifying a license returns a single license file and allows for allocation to another server. For exam-
ple, you have 5000 licenses installed on license serverl. You want to move 1000 licenses to license
server2. Modify allocations and then allocate 4000 licenses to license serverl and 1000 licenses to
license server2.

To select a product, click the link, and view the product license details page.
Select the check box of the allocated license to modify.

From the Select an action menu, choose Modify allocations.

Type a new server host address.

Select Modify license file.

I e

Select Yes, create license file. If you want to make a change before creating the license file,

select No, modify the allocation, and make your change. Then select Yes, create license file.

7. Select Download license file, and save the file to a temporary location. Remember the file
name and location where you downloaded the file. You need this location.

8. Install the license. See Install licenses.

Upgrade licenses

If you are eligible for a version upgrade as a benefit of your maintenance, you can download your CSS
Renewal license and add it to the License Server.

1. Atthe bottom of the landing page, select Upgrade my licenses.

2. Follow the site options and instructions for upgrading your product edition licenses.

3. Eitherdownload or order new media. An email message provides you with instructions to return
to citrix.com to allocate or receive more feature licenses.

4. Logon towww.citrix.com to allocate your licenses, generate a license file, download the li-
cense file to your License Server, and reread the file.

Hide and unhide licenses

Hiding licenses doesn’t remove them from an account. When you hide licenses, it removes them from
view. You might want to hide legacy product licenses. Hiding those licenses increases the visibility of
product licenses that you want to view.

1. Select the licenses you want to hide.

2. From the Select an action menu, choose Hide licenses.

3. To unhide licenses, choose Quick find: All hidden and select licenses.
4. From the Select an action menu, choose Unhide licenses.
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Manage multiple licenses (bulk actions)

You can apply actions to multiple licenses at the same time. Select the check boxes of different li-
censes and then select and action.

To apply actions to multiple licenses successfully, be aware of the following conditions:

+ You can apply certain actions only to licenses with the same attributes. For example, you can
only allocate licenses that have the same binding type. An error message appears when you
select licenses that are not compatible for the bulk action. The first license you select is what
subsequent selections are compared to for compatibility.

« If you select licenses that can’t have an action applied to all of them, some actions might be
disabled or not displayed, and a message might appear. For example, if you select two licenses,
one that has been allocated and one that has not, a message appears. The message states that
the action can apply only to allocated licenses.

Bulk actions X

One or more licenses are not allocated.

You can only apply this action to items that have been allocated.

If you continue, any licenses that have not been allocated are ignored.

Close and change selection

Filter licenses

Use the Filter by menu to narrow your list to expired licenses, new licenses, available allocations, or
trial licenses. From the Filter by menu, choose how you want to filter your output.

Create a product license report - Export to Excel (CSV)

Select this option to export your full list of assets and data to Excel.

1. Select the licenses you want in the report.
2. Choose the Export to Excel (.CSV) link. In the View my product page, it’s above the list of prod-
ucts. In the Manage my licenses page, it’s at the bottom of the list.
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3. Save thefile.

License Server administration without a console

August 16, 2021

There are several administration procedures that you can do without using the Citrix Licensing Man-
ager. We recommend that you use the console whenever possible. This article describes the proce-
dures required if you are unable to use a console.

+ Configure the Vendor Daemon log (CITRIX.log) from being overwritten
+ Customer Success Services renewal files

« Delete license files

« Disable the domain name truncation on Windows

« Find renewal and maintenance expiration dates

You can use the licensing management tool on citrix.com to download, allocate, install, modify alloca-
tions, return, and hide licenses. For more information, see Manage Licenses at citrix.com My Account.

You can use licensing commands to perform licensing tasks. For more information, see Licensing com-
mands.

Configure the Vendor Daemon log (CITRIX.log) from being overwritten

In License Sever version 11.16.6 build 34000 that does not support the License Administration Con-
sole, you can configure the Vendor Daemon log (CITRIX.log) from being overwritten as follows:

+ Goto LMGRD_LOG_FILE location (HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\FLEXIm
License Manager\Citrix Licensing\LMGRD_LOG_FILE) in your system.

« Add a + in front of the path. For example, example: C:\Program Files (x86)\Citrix
\Licensing\LS\Logs\lmgrd.log changes to +C:\Program Files (x86)\Citrix\
Licensing\LS\Logs\lmgrd. log as seen in the following image.

B Registry Editor - O X

File Edit View Favorites Help
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\FLEXIm License Manager\Citrix Licensing

Partner A || Name Type Data
iolntxeﬂ ab) (Default REG_SZ (value not set)
;:;;’;’t"ereﬂi-pph(atlcﬂs | cmdlineparams  REG_SZ local -x Imdown
Setup | License REG_SZ C:\Program Files (x86)\Citrx\Licensing\MyFiles;
K WOWSA22Nods 3| Lmgrd REG_SZ C:\Program Files (x86)\Citrix\ Licensing\LS\Imgrd.exe
Citrix -"‘%LMGED_LQG_FILE REG_SZ +C:\Program Files (x86)\Citrix\Licensing\LS\Logs\Imgrd.log
Classes ab|Service REG_SZ Citrix Licensing

Chients
v FLEXIm License Manager
Citrix Licensing
FNPIm
Google
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Customer Success Services

After you download your Customer Success Services renewal license file from citrix.com, you must add
it to your License Server. Copy the Customer Success Services renewal license files to the same direc-
tory as your existing license files and reread (using Lmreread) the license files. For more information
about the Tmreread command, see Reread license and options files (Imreread).

By default, this location is:
C:\Program Files\Citrix\Licensing\MyFiles on a32-bitserver
C:\Program Files (x86)\Citrix\Licensing\MyFiles on a64-bitserver

After you add the renewal license to your License Server, the license automatically unlocks any sub-
sequent versions of the product released during the Customer Success Services period.

To separate your licenses (two different licenses on two different servers):

1. Select a second server and install the License Server software.
2. Go to citrix.com to modify and allocate your original licenses into two new files. These original
licenses are contained in your current license file on the original License Server.
+ Allocate licenses to your first License Server for your first deployment.
« Allocate licenses to create another license file for the second License Server for your sec-
ond deployment.
3. Generate and download your Customer Success Services files and then copy them to the server
to which you want them applied.
4. Point all computers to the License Server running the version of the Citrix product you want
them to use. For information about pointing your Citrix product server to the License Server,
see your Citrix product’s administrator guide.

Delete license files

When you upgrade your edition (for example, Standard to Advanced, or Advanced to Premium) you re-
ceive new Citrix product licenses. You can allocate these licenses to one or many Citrix License Servers
through license files created at citrix.com. Rescinded licenses must be deleted from License Servers
within 90 days of new license purchase. Deleting the licenses enables:

« License asset management
« License compliance
+ Delete unnecessary alerts from appearing in the management console

Considerations when deleting files:

+ Incorrect removal of license files might inadvertently lower the total licenses available.
+ Place any new license files on the License Server before deleting any licenses.
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+ Delete a license file only when all INCREMENT lines in the file are obsolete or unnecessary. For
example, every increment line was replaced with a new license because of an upgrade.

Important
Never delete the options file (citrix.opt) or startup license (citrix_startup.lic).

1. Atthe License Server, open the Services panel and stop the Citrix Licensing service.
2. OpentheWindows Explorer and navigate to where the license files are stored. By default license
files are stored in:
e C: \Program Files\Citrix\Licensing\MyFiles on a32-bitserver
o C: \Program Files(x86)\Citrix\Licensing\MyFiles on a64-bitserver
3. Back up all license (.lic) files.
4. Using a text editor (we recommend Microsoft WordPad), open each license (.lic) file and identify
one or more obsolete license feature INCREMENT lines.
5. Ensurethatallincrement lines are obsolete or unnecessary. See License file format for informa-
tion about increment lines.
6. Close the file and change the file name extension from .lic to .old.
7. Inthe Services panel, restart the Citrix Licensing service.
8. Delete the renamed .old file.

Disable the domain name truncation
Warning

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

When you host multiple domains and multiple users who have the same user name on different do-
mains, you can leave the domain name truncation enabled. Forexample, jack@mycompany.com and
jack@newplace.com. If you have unique users on various domains, ensure that the License Server
does not truncate @domain.com.

The License Server detects Citrix Service Provider licenses and enables this functionality.
1. Locate the registry key:
For 32-bit machines: HKEY _LOCAL_MACHINE\SOFTWARE\Citrix\licenseserver

For64-bit machines: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\licenseserver

Name: UDUseDomain

2. Setthe registry key to 1.
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Data Description
0 The domain field is truncated. (default)
1 The domain field is not truncated.

Find renewal and maintenance expiration dates

You must have unrestricted access to My Account.

From a web browser, go to http: //www.citrix.com.

Select Sign In > My Account and type your user ID and password.
Select Renew and Manage Maintenance Programs.

Select Manage Renewal Contacts at top of page.

ok wn =

Renewal dates are listed next to each license under Current Expiration.

Licensing commands

August 30, 2021

While the Citrix Licensing Manager provides an easy method of accessing many licensing features,
you can also perform licensing tasks using commands. You might use the license administration com-
mands for advanced operations on the License Server that are not available in the console. Such
operations include diagnosing check-out problems using Imdiag.

License administration commands are stored in:

o C:\Program Files\Citrix\Licensing\LS on a32-bitcomputer
o C:\Program Files (x86)\Citrix\Licensing\LS on a64-bitcomputer

Description of the licensing commands
Note:

In License Server version 11.16.6 build 34000, existing user management lmadmin.exe is re-
placed with Citrix owned user management Imgrd.exe. Ensure you do not use Tmadmin.
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Licensing commands

Imgrd

Imdiag

Tmdown

Imhostid

Imreread

Tmstat

Tmutil

Tmver

udadmin

CtxManageUserAndGroup

CtxManageUserAndGroup.exe -useradd
“domain\username” -Role “admin/

user”

CtxManageUserAndGroup.exe -useradd
“domain\username” -Role *

adminGroup/userGroup”

Description

Starts and manages the licensing server and
other associated processes. 1mgrd is the core
licensing server file used for the Citrix licensing
Windows service. It hosts the license server
port (default 27000). Use the Citrix Licensing
Manager for licensing configuration and
administration tasks.

Diagnoses license check-out problems.

Gracefully shuts down the License Manager
and Citrix vendor daemons (disabled by
default).

Reports the host ID of the server on which
Citrix Licensing is running.

Causes the License Manager daemon to reread
the license file and start the Citrix vendor
daemon.

Displays the status of a License Server.

Displays a list of licensing utilities or runs other
commands.

Displays version information for the licensing
binaries.

Displays all licensed users and devices and
deletes specified licensed users and devices.
This command applies to user/device licenses
only. To get a list of licenses, specify

udadmin -list

Configures user and group access to manage
the License Server.

Command to add a user.

Command to add a group.
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Format license commands

Formatting conventions for the license administration commands:

Convention Description
Bold A command or switch, such as Imstat.
Italic Replace variables with a value. For example, in

the expression: Imstat -c license_file_list.
Before you run the command, replace
license_file_list with the names of one or more
license files.

[Brackets] Brackets around text indicate the options that
you can add to the command. It might indicate
that text within the brackets must be replaced.
For example: lmstat [-a] [-c
license_file_Tlist] [-f [feature]]
can be written as: C:\Program Files

(x86)\Citrix\Licensing\LS>lmstat.
exe —a -c @localhost -f XDT_ENT_UD

Universal arguments

Valid arguments for most license administration commands:

Argument Description
-all Displays all information about the License
Server.
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Argument

-C

-help

-s [server]

-verbose

Diagnose checkout problems (Imdiag)

Description

Lets you specify license files or License Server
port and host name. If you specify the path
without a license file name, the command
applies to all the license files in the directory.
For alocal host: -c @localhost. Fora
remote License Server: —-c¢ @servername. For
a License Server in a cluster:

-c @clientaccesspointname. Fora
specified path: —c path. For the names of one
or more license files:

-c license_file_list. Youcan enter more
than one license file path by separating each
path with a semicolon. Path names that
include spaces must be enclosed in double
quotes.

License handle, as reported by lmstat -a.
The license handle is a number used to identify
a specific checked out license.

Displays usage information and exits.

If you don’t specify a server, this argument
displays the status of all the license files listed
on the License Server or the license files on all
the License Servers.

Displays a longer description for all errors
found.

The Imdiag command allows you to diagnose problems when a product cannot check out a license.

In particular, you can test if your licenses are valid and if the License Server is running. When you run

this command, it attempts to check out a license.

You can also use the 1mdiag command to see if a specific type of license is working.

Example:

Run lmdiag on your Citrix Virtual Apps server Advanced edition licenses only. Specify MPS_ADV_CCU

as an argument.
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Syntax:

Ilmdiag -c license_file_list [-n] [feature[:keyword=value]]

Argument Description

-c license_file_list Diagnoses the specified files. You can also

use:-c @localhostor-c @server—-name

-n Runs in non-interactive mode. 1mdiag does
not prompt for any input in this mode.

feature Limits the feedback to the specified feature.

keyword=value If a license file contains multiple lines for a
particular feature, the result is limited to the
line containing the text value. For example:
Imdiag -c @localhost MPS_ENT_CCU:
HOSTID=LICSERVO1 attempts a checkout on
the line with the host ID LICSERVO01. Keyword
is one of the following: VERSION, HOSTID,
EXPDATE, KEY, VENDOR_STRING, ISSUER

If no feature is specified, 1mdiag operates on all features in the license files in your list. The Imdiag
command displays information about the license, then attempts to check out each license. When
the checkout succeeds, 1mdiag indicates that the checkout was successful. When the checkout fails,
lmdiag gives you the reason for the failure. The 1mdiag command tries to connect to each TCP/IP
port on the License Server. It detects if the port number in the license file is incorrect. Imdiag lists
each TCP/IP port number that s listening, and if -c license_file_list is specified, diagnoses the specified
files.

The 1mdiag command does not contact the computer running the Citrix product when it attempts to
check out licenses. The 1mdiag command indicates only if there are problems on the License Server.
That is, your product cannot check out licenses because it is pointing to the wrong License Server,
but lmdiag does not detect this problem. For example, a License Server that does not have licenses
for that product on it. The lmdiag command reports that it can check out licenses when the Citrix
product is pointing to the wrong License Server.

Stop daemons (Imdown)

The Tmdown command shuts down the License Manager daemon and the Citrix vendor daemon on
your License Server or all License Servers on your network. The Tmdown command is disabled by
default.
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Syntax:

Imdown -c license_file_1list [-vendor CITRIX] [-q] [-all]

Argument

-c license_file_list or -c @localhost or -c
@server

-vendor CITRIX

-q

-all

Run the Tmdown command on a License Server. You can use -all to shut down all the License Servers

on your network.

Description

Use the specified license files. We always
recommend specifying

-c license_file_list with lmdown. You
can alsouse:-c @localhostor

-C @server-—-name

Shut down only the Citrix vendor daemon. The
License Manager daemon continues to run.

Do not prompt or print a header. Otherwise,
Tmdown asks “Are you sure? [y/n]: .”

If multiple servers are specified, automatically
shuts down all of them. -q is implied with -all.

If Ilmdown encounters more than one server and you didn’t specify the -all argument, the command

displays a choice of License Servers to shut down. For example, the -c argument specifies a directory

with many *.lic files. Shut down the remote License Servers by using -c and specifying the name of

the License Server.

Note:

If you use the Task Manager to terminate the License Manager daemon (Citrix Licensing Service),

stop the Imgrd process first, then stop the Citrix vendor daemon process.

To stop and restart the Citrix vendor daemon only, use Imdown -c @localhost -vendor CITRIX,

thenuse lmreread -c @localhost -vendor CITRIX to restartthe vendor daemon.

Checks the license server binding information (Imhostid)

The Tmhostid command returns the host ID of the License Server. You can use the command to check

the host name of your License Server. You can open a license file and compare the host name in the

license file to that of your License Server.

Note

Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if
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there are more than one host.

Syntax:

Ilmhostid -bindingidentifier

Where bindingidentifier isthe argument.

Argument

-ether

-internet

-hostname

Reread license and options files (Imreread)

Description

Used for product licenses that are tied to the
MAC address of the appliance.

Used for Windows-based Citrix product
software licenses that require a TCP/IP address.

Used for Windows-based Citrix product
software licenses that are tied to the host
name of the License Server. Note: The
parameter hostname is case-sensitive and
must match your License Server name exactly.

The lmreread command causes the Citrix vendor daemon to reread changes to the license file and
the options file. After rereading, the Citrix vendor daemon uses the new settings and licenses from

then on.

You cannot use lmreread remotely; run it locally on the License Server.

Syntax:

Imreread -c license_file_list [-all] [-vendor CITRIX]

Argument

-c @localhost or -c license_file_list

-all

-vendor CITRIX

Examples:

Description

Use the specified license files.

If more than one lmgrd is specified, this
argument instructs all License Manager
daemons to reread.

Specifies for the Citrix vendor daemon to be
restarted.
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e Ilmreread -c @localhost \[-all\]
o« Ilmreread -c @client\\_access\\_point\\_name
* lmreread -c /opt/citrix/licensing/myfiles/CITRIX.lic -vendor CITRIX

Display the list of licensing utilities (Imutil)

The Tmutil command displays a list of licensing utilities when used standalone. When you specify
Tmutilwith another command, it runs that command.

Syntax:
Imutil
Tmutil other_command
Examples:
o Imutil
Displays all the licensing utilities.
e lmutil lmstat -c @localhost

Runs the Imstat command.

Determine licensing status (Imstat)

The lmstat command helps you monitor the status of all licensing activities and provides you with
information about license check outs, including:

» The product that checked out one or more licenses

« The checkout data

« The version of the license file

» The License Server name and port

« The date the license was checked out

« Information about the Citrix vendor daemon status and the license files

The lmstat command displays information that it receives from the License Server. The lmstat
command displays only one use of the license, even if there are multiple connections sharing that
license.

Syntax:

Imstat [-a] [-c license_file_list] [-f [feature]] [-i [feature] [-s[server]
[-S [CITRIX]] [-t timeout_value]
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Argument Description
-a Displays all information.
-c @localhost or -c @server or -c Uses the specified license files.

license_file_list

-f [feature] Displays the products using a feature (product
license). If you don’t specify a feature, usage
information for all features is displayed.

-i [feature] If you don’t specify a feature, this argument
displays information from the INCREMENT line
for the specified feature (product license) or all
features.

-s [server] If you don’t specify a server, this argument
displays the status of all license files listed on
the License Server or the license files listed on
all the License Servers.

-S [CITRIX] Lists all product servers using the features
(product licenses) served by the Citrix vendor
daemon.

-t timeout_value Sets connection timeout to timeout_value.

This value limits the amount of time Tmstat
spends attempting to connect to the License
Server.

Theoutputfromlmstat -c @localhost -alookssimilartothisexample. Thelinesinthe example
might break because of the screen space.

License Server status: 27000@localhost
License file(s) on localhost: C:\Program Files (x86)\Citrix\
Licensing\MyFiles\citrix_startup.lic:C:\Program Files (x86)\
Citrix\Licensing\MyFiles\License.lic:
localhost: license server UP v11.15.0
Vendor daemon status (on LicenseServer):

CITRIX: UP v11.15.0

Feature usage 1info:
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Users of CITRIX: (Total of 10000 licenses 7issued; Total of 1
licenses 1in use)

"CITRIX" v2038.0101, vendor: CITRIX, expiry: permanent(no expiration
date)
vendor_string: ;LT=SYS;GP=720;SA=0
floating license

XDT DDCPrinc-0001.citrix.com XDT XDT\_PLT\&MPS_PLT_2018.0518 (v1.0)
(localhost/27000 102), start Tue 5/8 17:59

Users of CTXLSDIAG: (Total of 10000 licenses issued; Total of 0
licenses in use)

Users of XDT_PLT_CCS: (Total of 200000 licenses issued; Total of 3
licenses 1in use)

"XDT_PLT_CCS" v2018.1201, vendor: CITRIX, expiry: 0l-dec-2018
vendor_string: ;LT=Retail;GP=720;PSL=10;CL=VDS,VDA,VDE,VDP;SA=0;0DP=0;
NUDURMIN=2880 ; NUDURMAX=525600
floating license

XDT DDCAux-0001.citrix.com XDT QOOO1E3A (v2018.0518) (localhost
/27000 534201), start Wed 5/9 15:17
XDT DDCAux-0001.citrix.com XDT 0O001E81 (v2018.0518) (localhost
/27000 392504), start Wed 5/9 15:18
XDT DDCAux-0001.citrix.com XDT QOOO1EOC (v2018.0518) (localhost
/27000 419703), start Wed 5/9 15:18
<!--NeedCopy-->

The following represents a breakdown of the information contained in the MPS_ENT_CCU line of the
Imstat output:

Description

Citrix product name MPS The name of the Citrix
product that has the license
checked out.

Host name mps_serverl Computer where the Citrix
productis running.
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Description

Display MPS Name of the Citrix product
that has the license checked
out.

Server host license_serverl Computer where the License

Server is running.

Port 27000 TCP/IP port where the License
Server is running.

Handle 203 License handle. The license
handle is a number used to
identify a specific checked
out license.

Checkout time start Wed 3/17 11:56 Time that this license was first
checked out.

The command lmstat -c @localhost -a can potentially generate much network activity in sys-
tems that have many products licenses checked out.

You can use lmstat -a to verify license checkout data.

Display versions of binaries (Imver)

The lmver command displays version information for the licensing binaries, such as the command
utilities.

Syntax:
lmver binary
Example:

lmver lmdiag

Display or release licenses for users or devices (udadmin)

The udadmin displays the licensed users and devices and releases licenses for specified users and
devices.

You can release a license for a user only when:

+ The employee is no longer associated with the company.
+ The employee is on an extended leave of absence.
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You can release licenses for devices only when the devices are out of service.
Caution:

Mass releases of licenses, before the automatic 90-day lease period, outside of the reasons high-
lighted earlier might violate the Citrix EULA. Before doing so, contact Citrix.

The udadmin command-line help displays usage information only in English, but you can use the
command on non-English systems.

Syntax:
udadmin [-options] [-delete | -events | -list | -times]

Options Description

-f feature name When used with -list or -delete, displays or
releases the license for only the user or device
for the specified feature name.

-user user name Releases the license for only the user specified
by the user name.

-device device name Releases the license for only the device
specified by the device name.

-a Lists all features and versions installed on the
License Server.

Argument Description

-delete Releases the license for one user, feature, or
device at a time.

-events Reports all events logged by the user/device
licensing for each feature sorted in
chronological order.

-list Displays the users and devices with licenses
and the time since the last update. If
significant activity occurred within 15 minutes
of the last report, the time to the next update
appears. Specifying -1ist -times generates
output containing a timestamp.

-times Specifying -1ist -times generates output
containing a timestamp.

No argumentor ? Displays usage information for the udadmin

command.
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Examples:

- udadmin -list -times
Usage data is @ minutes old. Next update in 15 minutes.
Users:
u@l.01 XDT_ENT_UD 2017.1201 (Thu Sep 14 13:41:07 2017)

u01.04 XDT_ENT_UD 2017.1201 (Thu Sep 14 13:41:07 2017)

Devices:
D.ADV.23 XDT_ADV_UD 2017.1201 (Thu Sep 21 18:31:01 2017)
DO1 XDT_PLT_UD 2017.1201 (Tue Sep 12 14:30:33 2017)

- udadmin -list -a

Lists all features, versions, counts of licenses, and the users and
devices for each feature.

- udadmin -f XDT_ENT_UD -device dn01.88 -delete
Releases one device from one feature.

<!--NeedCopy-->

Upgrade the License Server

July 9,2021

Before you upgrade

The following information helps you to prepare well before you begin your upgrade.

« Each time you upgrade your Citrix product, upgrade the Citrix License Server also. Each time
a new License Server is released, it might contain better security, fixes to known issues, and so
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on.

« Sometimes, new versions of the Citrix product are incompatible with older versions of the Li-
cense Server. New versions of the License Server are compatible with older versions of the
product and old licenses.

« Version upgrade is moving from any previous version of a product to the newest version of the
product. For example, moving from XenDesktop 7.18 to Citrix Virtual Desktops 7 1909.

+ Edition upgrade means the purchase of a higher edition level of a product. For example, you
now have Advanced Edition and you purchase upgrade to Premium Edition.

Prerequisites and precautions

« For information about system requirements, see System requirements.

+ Ensure you download the latest version of License Server, go to Citrix Downloads.

« Installing the License Server from a UNC path (\\server\share). Install the License Server from
your local copy.

+ Upgrade your licensing components before upgrading your product, if necessary.

+ Uninstall any versions of Citrix Licensing older than version 11.12.1 before installing this version.

+ To avoid the failure of any subsequent License Server upgrades: Ensure that when you installed
your License Server, you successfully configured it with the post installation License Server Con-
figuration tool or uninstalled your previous License Server.

How to upgrade the License Server

Citrix recommends that you install the newest License Server. The new License Server is backward
compatible and supports older products and license files. However, new products require the newest
License Server to check out licenses correctly. Perform the following steps to upgrade your License
Server:

1. Go to the Citrix Downloads page and download the installer to install or upgrade to the latest
version.

2. Startthe License Server installer (CitrixLicensing.exe) as an administrator, and follow the graph-
ical interface.

To upgrade the License Server from your product media:

If you use the product media for your installation, you might have to enable some functionality by us-
ing the Citrix Licensing Manager after your installation. For example, use the Citrix Licensing Manager
to enable Customer Success Services renewals.

1. From your License Server, open the media for your product.
2. If you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.
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3. Navigate through the Setup screens to Citrix Licensing and follow the instructions.
To upgrade the License Server from the command line:

Ensure that you run the command line with administrator privileges. To start the command prompt
with elevated privileges, choose Start, right-click Command Prompt, and choose Run as adminis-
trator.

You cannot change ports during command line upgrades.
The following sample command line installs licensing in silent mode.
CitrixLicensing.exe [quiet [linstall.log INSTALLDIR=installdirectory CEIPOPTIN=ANON

« /quiet specifies a silent (quiet) installation.
+ /lspecifies the log file location
« INSTALLDIR is the location where the License Server executable is stored. Optional parameter.
The default is c:\program files\citrix licensing or c:\program files (x86)\citrix\licensing.
« CEIPOPTIN specifies whether, or how, to optin to Citrix Customer Experience Improvement Pro-
gram (CEIP) or Call Home. Optional parameter. The default is ANON.
- DIAG-CallHome
- ANON - CEIP
- NONE

You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.
Important

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP)
and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

Events during a License Server upgrade

As part of the License Server upgrade, we stop services, upgrade the License Server, and then restart
services. During the upgrade, products enter the grace period and self-license. When the License
Server is online again, all product servers return from the grace period and reconcile license counts.
This grace period works in the same manner as the regular grace period functionality.

How to upgrade licenses for your edition

If you are eligible for a version upgrade as a benefit of your maintenance, you can download your
CSS Renewal license and add it to the License Server. Also change the product edition setting in the
product user interface. It’s best to change the product edition setting when there are few connections
to the affected servers or redirect connections to another computer. When you change the product
edition setting, restart the product server for changes to take effect. See the product documentation
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for changing the edition setting. If you add the upgrade license to the License Server before you set
the edition to the new edition, the Citrix product stops accepting new connections.

Perform the following steps to upgrade edition licenses:

From a web browser, go to http://www.citrix.com.

Choose Log In and type your user ID and password.

Select Manage Licenses.

At the bottom of the landing page, select Upgrade my licenses.

Follow the site options and instructions for upgrading your product edition licenses.

ok~ W=

Either download or order new media. An email message provides you with instructions to return
to citrix.com to allocate or receive more feature licenses.

7. Logon to www.citrix.com to allocate your licenses, generate a license file, download the license
file to your License Server, and reread the file.

Clustered License Servers - configure, install, upgrade, and uninstall

August 30, 2021

Why clustered License Servers

Cluster servers are groups of computers that are combined to increase availability, reliability, and
scalability. Clustering the License Server lets users continue working during failure situations without
interrupting their access to critical applications.

How clustered License Servers work

When the active nodein a cluster-enabled License Server suffers from hardware failure, failover occurs
automatically. Resources are available again in a few seconds.

A typical cluster configuration has, at a minimum, one active and one passive (backup) server. When
the active server in a cluster fails, the ownership of the resources in the cluster are transferred to an-
other node in the cluster. Typically, users cannot detect when one server in a cluster fails over to
another.

When the active node of a clustered License Server fails, there is no impact on users connected to
the Citrix product. The product might briefly enter the licensing grace period and an event might be
written in the product’s event log.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 112


http://www.citrix.com
https://docs.citrix.com/en-us/licensing/current-release/license-server/licensing-technical-overview.html#grace-period

Licensing 11.17.2 build 36000

Important:

If Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled,
connections can fail. Connecting remotely to the console or checking out licenses works until
failover occurs in the cluster. Exception rules for CITRIX.exe and Imgrd.exe are created during
the installation of Licensing, but do not work after a cluster failover. To work around this issue,
create exceptions for Licensing components on the Exceptions tab of the Windows Firewall
panel. Create an exception for each of the following ports:

+ License Server port number is 27000
+ Vendor daemon port number is 7279
+ Web Services for Licensing port number is 8083

Citrix Licensing in a clustered environment

Like most clusters, a private network is used to send heartbeats, commands, and state information
between the nodes of the cluster. If the connection is interrupted, the nodes try to reconnect by the
private network first, then the public network. The following diagram illustrates a cluster-enabled
licensing deployment:

Communications in a clustered licensing environment:
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Only one node can use the resources in a cluster at any given time. If you already deployed Citrix
Licensing and you want to migrate your deployment to a cluster-enabled server, keep the following

points in mind:

« Because you already generated license files that reference a specific server name, you must give
the client access point the same name as the original License Server. If not, then rehost your
license files with the new name of the License Server cluster.

« Host names in license files are case-sensitive; therefore, the client access point names must be
the same case as the host names in the licensefile. If they are not, you must rehost your license
files with the correct capitalization of the names. You can use the Failover Cluster Manager to
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ensure that the client access point name matches the host name specified in the license file.
Cluster and host name case is not an issue if you use Studio in Citrix Virtual Apps and Desktops
or the Citrix Licensing Manager (from the Start menu on your License Server) to download your
licenses.

Point all product installations (for example, servers running Citrix Virtual Apps and Desktops)
serviced by the old License Server to the new License Server cluster. Change product communi-
cation settings so that they use the name of the client access point as the License Server name.
For information about editing product-side communication settings, see the product’s docu-
mentation.

Prerequisites to configure a clustered License Server

The following list outlines the requirements for setting up a License Server in a Microsoft Cluster:

Microsoft clustering functionality exists in:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2

Citrix Licensing does not support Clustered Shared Volumes or third party Volume Management
products for clusters.

Before configuring Citrix Licensing for Microsoft clustering, you must have a fully functional Mi-
crosoft cluster environment. Citrix Licensing Services runs on only one node at a time.

To cluster the License Server, follow these cluster requirements in addition to any requirements
from Microsoft for hardware and clustering in general.

Install licensing on the cluster with the License Server installer CitrixLicensing.exe.

When you install Citrix Licensing on a cluster, specify the name of the client access point. You
are prompted for the name of the License Server during product installation.

We recommend that you use identical License Server hardware for each node in the cluster. In
particular, Citrix recommends two network adapters on each node and the servers configured
with a shared disk.

Ensure that each node has two network adapters. One for the connection to the public network
and the other for the node-to-node private cluster network. We do not support using one net-
work adapter for both connections.

The public and the private IP address must be on different subnets because the Cluster Service
recognizes only one network interface per subnet.

A name resolution method, such as DNS, WINS, HOSTS, or LMHOSTS, is necessary to resolve the
client access point name.
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Each server that forms the cluster must be in the same domain.
Set static IP addresses for the private network connector.
We recommend that you use the Citrix Licensing Manager to allocate licenses to the cluster.

When you generate a license file at citrix.com, use the name of the client access point when
prompted for the Host ID.

After you download a license file, copy it to the F:\Program Files\Citrix\Licensing\
MyFiles folder (where F: is the shared drive for the cluster) on the License Server and reread
it.

Important:

Citrix recommends setting static IP addresses for all network adapters in the cluster, both private

and public. If using Dynamic Host Configuration Protocol (DHCP) to obtain IP addresses, access

to cluster nodes might become unavailable if the DHCP server goes down. If you must use DHCP

for your public network adapter, use long lease periods to ensure that the dynamically assigned

lease address remains valid even if the DHCP service is temporarily lost or perform a DHCP reser-

vation.

Configure a clustered License Server

The following steps describe the overall process involved in installing and configuring licensing on a

cluster-enabled server. These steps assume you configured the clustering on the hardware on which

you intend to install the License Server.

1.

Create a cluster resource group. Assign a client access point and shared storage to the resource
group. Ensure that the first node has control of the cluster resources and the resource group
you created points to the first node.

On the first node of the cluster, start the Citrix Licensing installer, CitrixLicensing.exe, as an ad-
ministrator. Install it on the first node to the shared cluster drive (not the quorum drive). Leave
the Last Node in the Cluster check box cleared.

. Move the resources from the active node in the cluster to the second node.

Install the License Server on the second node to the same shared location as the first node. You
can add more than two nodes to a cluster.

When installing the License Server on the last node in the cluster, ensure that you check the Last
Node in the Cluster check box.

Obtain license files that specify the client access point name of the License Server as the host
name. After obtaining license files, you must add them to the License Server and then reread
them.
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7. Configure your Citrix product to use the client access point name, not the node name of the
License Server cluster.

Important:
When a clustered License Server fails over, the cluster service renames the Imgrd_debug.log to

the name of the node that previously hosted the services. Then it starts the services on the new
active node and creates a Imgrd_debug.log.

Install licensing on a cluster-enabled server

Important:

The .msi does not support clustering. To install or upgrade for clustering, use CitrixLicensing.exe.

The following drive letters and paths/variables are used in this procedure:
« Disthe drive for your product media.
« Cisthelocal hard drive on the specified node.

» Fistheclustershared driveresource. (Thisdriveistheinstallation drive. Thatis, the place where
installation files used by each node are stored.)

Because of a NetBios restriction, ensure that the client access point name is fewer than 15 characters.
On non-English platforms, when starting a License Service installation on a cluster node, the Cluster
Group list on the Configure screen might contain the system default Cluster Group. Select one of the
non-default Cluster Groups and the installation continues normally.

1. Create a separate, noncore cluster resource group. The resource group must have the attached
storage assigned a drive letter and a client access point. The client access point must have the
same host name used when obtaining the license file. Use the Failover Cluster Manager and
Roles > Configure Role in Windows Server 2012 R2, Windows Server 2016, and Windows Server
2019. Then select the Other Server type in the menu. Ensure that the first node of the cluster
owns all cluster resources.

2. Run the License Server installer, CitrixLicensing.exe, as an administrator.
On the Install Location page, set the drive letter to correspond with the cluster shared drive. By
default, the licensing components are installed in F: \Program Files\Citrix\Licensing.

3. Leave the Last Node in the Cluster check box cleared during the installation on the first node.
4. Move the resources for the resource group you created in Step 1 to the second node.
5. In node 2 of the cluster, run CitrixLicensing.exe as an administrator.

6. Go backto Step 3. You can install more than two nodes on the cluster. You can install more than
two nodes on the cluster. For each additional cluster, repeat Step 3.
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7. When installing the License Server on the last node in the cluster, ensure that the Last node in
the cluster check box is checked. The last node is where the ports are configured.

8. Use the Citrix Licensing Manager to import your license files.

Open the console or run commands

Alllicensing administration features available in standard deployments are also available on clustered
License Servers. These features include the management console and the ability to run license admin-
istration commands.

Browse to the following location to open the Citrix Licensing Manager in a cluster:
https://client access point name:web service port

Where the client access point name is the name of the cluster and the web service port is the port
number for console communications. The default port number is 8083. To specify the location of the
license files in the cluster, you can run many license administration commands using the argument -c
@client access point name. For example:

Ilmreread -c @client access point name -all

Upgrade a clustered License Server

To upgrade your clustered License Server (from versions 11.12.1 onwards) to the latest version, com-
plete the following steps:

1. Download the latest License Server build.
2. Runthe License Server installer CitrixLicensing.exe as an administrator.

3. Move the resources for the resource group you created when you installed licensing on a clus-
tered enabled server, to the second node.

4. In node 2 of the cluster, run CitrixLicensing.exe as an administrator.
5. If you have more than 2 nodes on the cluster, repeat Step 3.

6. Use the Citrix Licensing Manager to import your license files.

Note:

If you are running a version of a License Server older than 11.12.1, uninstall it and then install
the 11.16.6 version. These older versions of License Server do not conform to current Microsoft
cluster guidelines. The 11.16.6 version of the License Server has the functionality required to
support Windows Server versions 2008 and later.
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Uninstall a clustered License Server

Uninstall licensing from a clustered License Server using the Control Panel > Programs and Features
option from the active node.
Ensure that the first node contains all the resources.

1. From the first node in the cluster, start Control Panel > Programs and Features.
2. Remove Citrix Licensing.

3. Usingthe failover cluster manager, move the resources in the Citrix Licensing resource group to
the second node.

4. Remove Citrix Licensing from the second node. If there are more nodes, repeat Steps 3 and 4
for each node, and then proceed to Step 5.

5. Remove the remaining files from the shared drive.
Note:

The uninstallation process does not remove the license files and options file from the shared
drive. For more information, see Troubleshoot Licensing.

Disaster recovery backup and redundancy

September 16, 2021

Depending on how crucial the applications associated with your licenses are, you might want to create
backup License Servers. Although Citrix stores backup copies of your licenses, downloading many
replacement licenses can be time-consuming. If the License Server fails, you can store backup licenses
on a network file share, or have a configured backup License Server ready.

You can use the same licenses for your disaster recovery site that you use for your production environ-
ment.

+ Configure and manage your disaster recovery environment independently of your production
environment.

+ Don’t use both the production and backup License Servers to service license checkouts at the
same time.

« Make only one License Server accessible at any one time

» The License Server in your disaster recovery environment must have an identical host name to

the License Server in your production environment.
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When the License Server is offline for maintenance activity

The standard 30-day grace period allows your systems to continue to function without degradation of
performance or denial of service to support License Server maintenance requirements.

What can | do if my License Server is unrecoverable?

When you have a backup copy of your license files available, you have 30 days to do the following:

1. Rename an existing server in your environment to have the identical host name as your original
License Server.

2. Install the License Server component and your backup license files to relicense your environ-
ment.

What can | do if my License Server is unrecoverable and | do not have a backup copy of
my license files immediately available?

When you don’t have a backup copy of your license files immediately available, you have 30 days to
access your My Account > Manage Licenses portal at www.citrix.com. To relicense your environment,
do the following:

1. Download your license files.

2. Rename an existing server in your environment to have the same host name as your original
License Server.

3. Install the License Server component and the license files you downloaded.

What can | do if my License Server is unrecoverable and | cannot rename an existing
server in my environment?

When you can’t rename an existing server in your environment, you have 30 days to relicense your
environment. Do the following:

Identify another server in your environment.

Install the License Server component.

Access your My Account > Manage Licenses portal at www. citrix.com.

Return and reallocate your license files using the host name of the new server you selected.

ok w D

Download and install these license files.

Does any failure of the License Server degrade performance or deny service to users?

No. The 30-day grace period prevents you from experiencing degradation in performance and denial
of service to users.
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Redundancy solutions

Setting up redundancy solutions might be necessary only in mission-critical environments. For
smaller or less mission-critical deployments, you can back up your License Server by creating a
duplicate License Server and store it on or off the network.

You can ensure redundancy for your mission-critical environments by:

« Creating a clustered License Server. For more information about clustering and licensing, see
Setting up the License Server on a Microsoft Cluster.

+ Using the high availability feature on XenServer minimum release version 5.6.

+ Duplicating the License Server and its contents. Give the duplicate computer the same name as
the active License Server and store it off the network.

« Storing another License Server that has a different server name on the network. In this case,
when the active License Server fails, you must change the backup server name to start using it
as the active License Server.

+ Using a network appliance. If you are using only one License Server to service license requests
at any time, you can use a network appliance that detects server or network outages and route
traffic to a backup License Server.

All methods let you exchange one server license for another without a loss of service, provided the
exchange occurs within the grace period. For more information, see Grace period.

Remember these key points:

+ Because license files reference the server specified during allocation, you can use the files only
on a server that has the same binding information. That is, the server name or FQDN or MAC
address (possibly displayed on the portal as an Ethernet address) as the original License Server.

» You cannot have two License Servers that have the same name on your network active at the
same time.

« Add any other licenses that you download to both the active License Server and the backup
License Server.

Troubleshoot the License Server

May 17,2021

If any of the licensing services fail to start, the cluster detects that licensing is offline and tries to restart
the service three times (by default). When these attempts are unsuccessful, fail over to the next node
begins. The cluster tries to start the services on the second node. When the attempts fail on the second
server, the process might enter into an infinite loop. In this case, the computers running the Citrix
products fall into the grace period. During the grace period, client connections are not affected.
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Troubleshoot the cluster-enabled License Server

When troubleshooting a cluster-enabled License Server, try the following:
« If you move the resources to the other node, do you still see the issue?

« If the installation fails, ensure that you don’t enable the User Account Control (UAC) when in-

stalling on a cluster.
+ For Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2:

1. Inthe Failover Cluster Management window, from the left pane, select the cluster. In the
middle pane, the summary information for the cluster appears.

2. Select the Cluster Core Resources title to expand the section.

3. Verify that the cluster resources are all online (green arrow).

The “-evaluation license-”” warning message

After you replace the evaluation license files on the License Server with new license files, the Citrix
product might display the following license expiration message when users log on: Warning: The

following Citrix Product is using an Evaluation license. This license will

expire in...
To resolve this issue:

1. Deletethe old evaluation license files from the License Server. For more information, see Delete

license files.

2. Atthe License Server, restart the Citrix Licensing service.

3. Atthe Citrix product server that needs license validation, point to a fictional License Server and
then point the product back to the actual License Server. (See your product documentation for
information about changing these settings.)

4. If the problem persists, restart the product server (for example, Delivery Controller).

Required product licenses are not installed on Director or Studio

The following error message is displayed on the Citrix Virtual Apps and Desktops Director or Studio
ul:

» Required product licenses are not installed
« Trial period has expired

The following reasons can cause the error messages:

+ Novalid licenses are installed on the License Server
+ Product Edition and Product Model are not set correctly on Citrix Studio
« If the maintenance dates of the licenses are not compatible with the product version installed
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To resolve this issue:

1. On Citrix Studio, check if the licenses are reflecting the correct maintenance dates. If not, real-
locate and import renewed licenses. For more information, see the Citrix article CTX134629.
2. Verify if Citrix Studio is pointing to a valid License Server.
3. Click Edit Product Edition under Actions and choose correct licensing edition or model as per
the licenses applied.
« If the right edition or model is set and still the error remains, toggle between the license
editions and then choose the correct one.
« Ifthe above steps do not work, click “change license server” under actions and click con-
nect.
4. Relaunch Citrix Studio and then reboot the product server if the issue still persists.

Note:

License server VPX is not compatible with Citrix Virtual Apps and Desktops (Version 7.x and

above).

Licensing FAQ

August 16, 2021

The following questions are asked frequently about your licensing environment.

Licenses
What is a license file and what do | do with it?

The license file is a text file that contains the following:

+ Product licensing information

« License Server name (or other binding identifier)

« Customer Success Services membership renewal date
« License expiration date (if applicable)

+ Other system information

When you purchase a Citrix product and allocate licenses, a license file is generated. The License
Server uses this file to determine whether to grant a license to a Citrix product. For more information,

see License files.
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Why would I return a license?

An example would be if you’re decommissioning a License Server, but you’re not ready to deploy ex-
isting licenses elsewhere. For more information, see Return allocations.

What happens to returned licenses?

Returned licenses are put back in the licensing pool. You can then allocate these licenses in any quan-
tity at any time. After you return a license, remove the old license file from the License Server. For
more information, see Return allocations and Modify licenses.

What happens when | hide a license?

Hide (previously called archiving) doesn’t remove licenses from an account. Hiding removes them
from view. To view hide and unhide licenses, see Hide and unhide licenses.

How can | get a copy of my license file?

You can obtain a copy of your licensefile from your License Server. Alternatively, all purchased licenses
and allocated license files are available from the secure My Account > Manage Licenses portal at
www.citrix.com.

Allocating licenses

For more information about allocating licenses, see Allocate licenses.

What does allocating licenses mean?

When you allocate licenses, you apportion purchased licenses by product and License Server so you
can split them among multiple environments or use cases. For example, your organization might
own 1,000 licenses for the same product. You might want to use 800 in 1 location and 200 in another
location. You can allocate 800 licenses to a License Server in the first location today, and allocate the
remaining 200 later to a different License Server.

What’s the difference between a host ID type and a host ID?

The host ID type is the required binding type you supply to allocate licenses. The host ID is the License
Server host name, MAC address, or other binding ID required to allocate licenses.
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Why can’t | partially allocate some licenses?

Some licenses do not allow partial allocation.

The License Server
Can |l rename the License Server?

License files run only on the License Server that is bind during the license allocation. License files
contain the host name or binding identifier of the License Server you specify when you allocate the
licenses. You cannot use the license file that you generated for a particular License Server or a MAC
address (for an appliance), on a different License Server or appliance.

Create license files that reference the new server name or MAC address by returning allocations and
generating the new file on citrix.com. For more information, see Manage Licenses on citrix.com.

If | upgrade my License Server does it affect my license files?

No. The License Server and all product licenses are fully backward compatible and do not introduce
any issues into your environment. For more information about upgrading the License Server, see
Upgrade the License Server.

Can a single License Server supply licenses to users connecting from different servers using
different product editions?

Yes. One License Server can contain licenses for multiple editions of a Citrix product. The type of
license checked out corresponds to the edition that is configured on the product server. A product
server is configured to consume a specific edition of a license and checks out that license edition.

For more information and examples, see Single License Server and different servers using different
product editions.

License Administration Console
Where is the License Administration Console?

The License Administration Console is not available in License Server 11.16.6 and later. We recom-
mend you
use the Citrix Licensing Manager to manage the License Server.
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How to configure the Vendor Daemon log (CITRIX.log) from being overwritten while using
11.16.6 build 34000 that does not support License Administration Console?

For information, see Configure the Vendor Daemon log (CITRIX.log) from being overwritten.

Disaster recovery and maintenance
How do I license my disaster recovery site?

You can use the same licenses for your disaster recovery that you use for your production environ-
ment.

+ Configure and manage your disaster recovery environment independently of your production
environment.

« Don’t use both the production and backup License Servers to service license checkouts at the
same time.

+ Make only one License Server accessible at any one time

« The License Server in your disaster recovery environment must have an identical host name to
the License Server in your production environment.

For more information, see Disaster recovery - back up and redundancy.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 126


https://docs.citrix.com/en-us/licensing/current-release/admin-no-console.html#configure-the-vendor-daemon-log-citrixlog-from-being-overwritten
https://docs.citrix.com/en-us/licensing/current-release/backup.html

Licensing 11.17.2 build 36000

© 1999-2021 Citrix Systems, Inc. All rights reserved. 127



: I- ° Locations
C | rl X .. Corporate Headquarters | 851 Cypress Creek Road Fort Lauderdale, FL 33309, United States
Silicon Valley | 4988 Great America Parkway Santa Clara, CA 95054, United States

© 2021 Citrix Systems, Inc. All rights reserved. Citrix, the Citrix logo, and other marks appearing herein are property of
Citrix Systems, Inc. and/or one or more of its subsidiaries, and may be registered with the U.S. Patent and Trademark

Office and in other countries. All other marks are the property of their respective owner(s).

Citrix Product Documentation | docs.citrix.com September 30, 2021



	Licensing 11.17.2 build 36000
	What's new
	Fixed issues
	Known issues
	Third party notices
	License Server
	Licensing elements
	Licensing services
	Citrix licensing technical overview
	License files
	License types
	Transition and Trade-Up (TTU) with Hybrid Rights
	System requirements for Citrix Licensing
	Get started, install, and configure the License Server
	Prerequisites to obtain your license files
	Customer Success Services
	Citrix Licensing Manager
	Dashboard and Historical Use
	Install licenses
	Update licenses
	Settings
	Register and remove registration of your Citrix License Server
	Manage Licenses on citrix.com
	License Server administration without a console
	Licensing commands
	Upgrade the License Server
	Clustered License Servers – configure, install, upgrade, and uninstall
	Disaster recovery backup and redundancy
	Troubleshoot the License Server
	Licensing FAQ

